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Genesys Interactive Insights 8.5 User's
Guide
Welcome to the Genesys Interactive Insights User's Guide. Genesys Interactive Insights (GI2)
provides reports that summarize contact center activity and an entire universe of elements (the
GI2_Universe) that support them.

This is the first page of this document. Use the navigation buttons on the left to move to other pages
in the document, or the links at the bottom of the page to move forward/back through the document,
one page at a time.

This guide picks up where the Genesys Interactive Insights Deployment Guide leaves off. Begin to use
this document only after you have configured Genesys Info Mart 8.5 and its supporting applications
to measure and record contact center activity, installed and set up your BusinessObjects Business
Intelligence Platform (BI) 4.1 environment, and installed and imported the appropriate reports and
universe. This document describes:

• how to manage the reports that are deployed with GI2,
• how to create or modify reports and the supporting universe elements using BI software,
• how universe elements are organized to paint a picture of contact center activity within your enterprise.

This document describes the 8.5.x release(s) of GI2. For other releases of GI2, visit the Genesys
Customer Care website, or request the Documentation Library DVD, which you can order by email
from Genesys Order Management at Genesys Order Management. GI2 8.5.x releases rely on
BusinessObjects Business Intelligence Platform (BI) 4.1, which provides functionality similar to that
provided by BO XI 3.1 in releases 8.1.1 and earlier, though the names of some applications, tools,
and options differ.

BI 4.1 software

GI2 8.5.0 is powered by BI 4.1 software. This document does not describe in detail how to operate BI
software, because that information is provided in documentation provided by SAP. For more
information about the operation of BI Launch Pad, Web Intelligence, or the Design tools, refer to the
BO/BI documentation, available from the following sources:

• from the SAP BusinessObjects Business Intelligence Platform Documentation CD,
• if you are a direct SAP customer, you can acquire the BusinessObjects documents from the SAP website,
• if you obtained BI software through Genesys, you can acquire BusinessObjects documents from this

page on the SAP website.

Refer to the Genesys Interactive Insights Universe Guide for more information about GI2 universe
elements and reports.
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Tip
Because you can customize the appearance and functionality of BI user interfaces,
screens shown in this guide might differ from what you see in your environment.
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New In This Release
This section describes the changes that have been incorporated within this guide since the 8.5.0
release of GI2.

For information about what's new in the software, see the Genesys Interactive Insights Release
Notes.

Genesys Interactive Insights 8.5.000.03

Added information about GI2 releases that are incompatible with BI 4.2.

Genesys Interactive Insights 8.5.000.02

This is the initial release of this new document.

Other Changes

Changes pertaining to the the deployment and localization of GI2 are described in the Genesys
Interactive Insights Deployment Guide. Also, refer to the Genesys Interactive Insights Universe Guide
for information about the new reports and other new universe elements that were introduced or
updated within the 8.5.x releases.
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Licensing Restrictions
GI2 and Genesys Info Mart licensing allow you to add third-party data to enrich the reporting and
analysis of your enterprise operations. You may use GI2, including the BI Web Intelligence
component, to report on any Genesys data sources. However, when reporting on non-Genesys data
sources, GI2 reports must contain data from at least one Genesys data source. The number of
concurrent users who can operate BO software in your environment is controlled by the number of
GI2 seats that you have purchased. To obtain unrestricted licenses that enable you to freely access
data sources other than Genesys Info Mart, contact SAP.

GI2 8.5.0 is based on the Enterprise Edition of BI 4.1.
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Managing the BI 4.1 Environment

CMC Home Page

This page describes the BI environment. Genesys Interactive Insights (GI2) is based on BI 4.1, which
you manage using the Central Management Console (CMC). The figure CMC Home Page shows the
CMC home page, which summarizes the tasks that administrators can perform with this tool.

CMC is a web-based application that you can use to control individual preferences. The BI
Administrator must grant permission for you to access the CMC.

Use BI software to perform the following key administrative tasks:

Managing Folders

Setting Folder Permissions Within CMC

BO software uses folders to organize repository documents. You control access to these folders and to
specific items within them by setting permissions. The figure Setting Folder Permissions Within CMC
shows user security permissions being invoked for a GI2 report.
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Release-specific subfolders of the Interactive Insights root folder house report and
documentation subfolders. This folder structure enables you to maintain any customizations that you
applied to previous universes. In this document (and other GI2 documentation) text references and
screen shots might omit the release-specific subfolders.

A BI 4.1 installation deploys many default folders—such as Administration Tools, Auditor, and
Report Samples—that are not used by GI2. As the BI administrator, you can hide these folders to
avoid confusion. To hide folders from select groups of users, apply no-access levels to those groups
within the security profile of the folder’s properties. Refer to the “Manually Setting Up GI2 Access
Levels, Groups, and Permissions” section of the Genesys Interactive Insights Deployment Guide for
further details.

The Genesys Interactive Insights Deployment Guide instructs you to delete the root folder
(Interactive Insights) prior to redeploying GI2 or reimporting the same GI2 universe version.
Before you delete this folder, archive any custom reports that exist in the folder.

To prevent the installation routine from overwriting a preexisting universe (GI2_Universe), you must
export the universe to an LCMBIAR file using Promotion Management in CMC. When you customize
reports, consider using a storage location that minimizes the need to relocate these custom reports
when new releases of GI2 become available.

Managing Servers

You can view and modify server settings and stop and start BI servers by using the CMC or Central
Configuration Manager. Use either tool to troubleshoot your BI environment when you cannot access
the GI2 universe or reports.

A BI installation deploys a set of servers; in some cases you may not need all of them. If you choose
to stop servers you do not need, be sure to leave running all servers that are required by GI2. Refer
to the Business Intelligence Platform Administrator Guide for a description of the servers and how to
manage them (see BO/BI documentation).

Stopping the Adaptive Processing Server by Using
CMC

The figure Stopping the Adaptive Processing Server by Using CMC shows the process to stop an
unused server using the CMC. If you use BO functionality that requires these servers, such as
scheduling reports or setting up rules or events, make sure that you leave the required servers
running. Refer to the Business Intelligence Platform Administrator Guide for a description of the

Managing the BI 4.1 Environment Licensing Restrictions

Genesys Interactive Insights User's Guide 8

https://docs.genesys.com/Documentation/GI2/latest/Dep/EnvSetup#ManuallySettingAccessLevelsGroupsandPermissions
https://docs.genesys.com/Documentation/GI2/latest/Dep/Welcome


servers and how to manage them (see BO/BI documentation).

Managing Connections

The GI2 installation routine copies a database connection object (GI2_GIM_DB) when it imports the
GI2 universe into the BI repository. This connection is reserved for Genesys use; use or modify it only
as directed. Refer to the Genesys Interactive Insights Deployment Guide for step-by-step instructions
on how to link the GI2 Universe to your data source (your Info Mart database).

Managing the Universe

The BI 4.1 installation routine deploys several sample universes in the Universes root folder,
including eFashion, Monitoring TrendData, and Report Conversion Tool Audit. These universes
are not used by the GI2 reports, and you can ignore them. The installation routine deploys the
GI2-specific universe (GI2_Universe) in a release-specific subfolder of the Interactive Insights
root folder. You control which users have write access to the GI2_Universe by setting user permissions
appropriately in CMC. Extend this permission only to those users who need it; editing the universe
can affect report results for all who receive them, especially if the changes are imported back into the
repository. The Genesys Interactive Insights Universe Guide describes which measures of the GI2
universe are directly used in the GI2 reports.

Important
BI 4.1 has no mechanism for tracking or reversing the changes made to a universe
once it has been imported into the BI repository.

Managing Users, Groups, and Access Levels

The insights.lcmbiar file, which is deployed during installation of GI2, includes the groups that are
shown in the following table and the corresponding access levels. To complete configuration, and
make the various objects of the GI2 repository available to other users in your contact center, you
should set up BI accounts using the identification information of the users. You can assign these users
to the predefined Interactive Insights user groups using the predefined access levels, or you can
assign users to groups that you create with custom permissions. For instructions on how to assign
users in a BI environment, refer to the Business Intelligence Platform Installation Guide for your
specific operating system (see BO/BI documentation).
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Interactive Insights User Groups

The following table describes the user groups that are available in GI2:

Group Summary

Interactive Insights report developers

Interactive Insights report developers can create
reports in Web Intelligence from scratch, delete
them, and edit and view their underlying SQL.
Report developers can also schedule reports for
later running and distribution and save them in
other formats, such as PDF and Microsoft Office
Excel.

Interactive Insights report editors

Interactive Insights report editors can modify
existing reports and copy them in order to create
new reports. However, they cannot create new
reports within the GI2 universe in any other
manner. Report editors can also schedule reports
and save results in other formats.

Interactive Insights report viewers

Interactive Insights report viewers can specify
values at the user prompts when they run the
reports, view report results, and modify
reports—however they cannot save the
modifications. Report viewers can also schedule
reports and save results in different formats.

Interactive Insights report basic
Interactive Insights report basic users can see
scheduled and existing report instances. A user
within this group, however, cannot run reports or
see the Details folder.

Interactive Insights access restrictions

Interactive Insights access restrictions users can
see only certain data and reports. Users within this
group have their access to data restricted based on
geography, line of business, or organizational role.
Specific data can also be blocked (such as system
objects).

For information about tasks not covered here, refer to the Business Intelligence Platform
Administrator Guide for additional information about working with Central Management Console (see
BO/BI documentation).
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Understanding Reports and Workspaces
This section helps you understand GI2 reports and BI Workspaces, how to work with them in Web
Intelligence, and how to customize them to suit your needs. The GI2 reports and BI Workspaces for
Genesys Info Mart compile contact center interaction activity and agent-summarized states for
telephony and multimedia DNs. Agent-based reports and workspaces do not contain data that
summarizes virtual interactions, virtual agent activity, and Interactive Voice Response (IVR) port
activity. However, if IVRs are configured as handling resources in your environment, data that
pertains to IVR ports is included in the business attribute and interaction detail workspaces reports.

About BI Workspaces

Managing Workspaces

BI Workspaces provide dashboard-like displays of one or more charts of contact center activity. Each
workspace is effectively a container for specially-designed reports. This release provides one
customizable workspace, Call Center Monitor, which is composed of the following reports,
represented on four tabs:

• Accepted Performance— This tab links to the Interaction Traffic Report, displaying four charts.
• Agent Performance— This tab links to the Agent Summary Activity Report and the Agent Utilization

Report, displaying two charts and a table that summarizes each agent's call volume, utilization, and
revenue.

• Business Result— This tab links to the Interaction Volume Customer Segment Report, displaying four
charts.

[+] Read More About BI Workspaces
The workspace charts are designed using Web Intelligence, which is an application in the
BusinessObjects (BO) Business Intelligence Platform suite. Workspaces are stored in one subfolder:
Workspaces.

Understanding Reports and Workspaces Licensing Restrictions
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For optimal viewing of the workspaces, set your screen resolution to a width of at least 1280 pixels.

The figure Managing Workspaces shows the organization of the workspaces in the BI Workspaces
folder and some of the operations that you can perform within Web Intelligence.

The data in the workspaces represents a snapshot of the database at a given point in time; to view
current data, you must refresh the data (see Refreshing Data for related information on this topic).
Also, consider scheduling regular runs of the constituent reports, as the workspaces do not display
the date range over which the reports were run. Workspaces can display more than one chart from a
single report, or can display charts from more than one report. You can refresh the data in a
workspace either from the workspace itself, or by running each report before opening the workspace.
When you refresh, the values that you specify at the user prompts apply only to the report for which
the user prompt was invoked, with one exception: any associated (hyperlinked) standalone report
inherits the prompt values from the called report only if these user prompts are populated.

About GI2 Reports

Managing Reports

The GI2 release for Genesys Info Mart 8.5 includes the following reports:

• 16 agent activity reports
• 7 queue activity reports
• 6 detail reports
• 2 callback reports
• 3 outbound contact reports
• 9 business attribute reports

All of these reports were designed using Web Intelligence. The reports use the hierarchies, classes,
dimensions, details, conditions (filters), measures, and prompts that are defined in the corresponding
Interactive Insights universe: GI2_Universe. The figure Managing Reports shows the organization of
some of the reports in the Agents folder and some of the operations that you can perform within Web
Intelligence. To learn about performing basic report operations, such as running and scheduling
reports and printing, sharing, and exporting their results, refer to the BO/BI documentation.

• [+] Common Elements of Design Across All Reports
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Viewing Reports Using Web Intelligence (top half)

Viewing Reports Using Web Intelligence (bottom half)

When you view, run on-demand, or modify a report, the report opens in the Web Intelligence interface, as depicted in the figure
Viewing Reports Using Web Intelligence. As an administrator, you can configure permissions that determine whether Web
Intelligence is available for each user and which operations each user can perform.

Main and Description Tabs
Each report includes a User Prompt Input area, a Description tab (in most reports) that describes the report’s measures,
and a Main tab (in most reports) that contains one report. A few reports have a different design:

• The Agent Summary Activity Report provides 4 reports displayed on 4 main tabs (Active Time, %
Active Time, Interaction Time, and % Interaction Time).

• The Agent Utilization Report uses 2 main tabs (Customer and Consult).
• Instead of a main tab, the Business Executive Report provides 3 summary tabs (Business

Result, Customer Segment, and Service Type).

Main and Date Range Queries
If your user account has access permissions of an Interactive Insights Editor or Developer, the Edit button is available to you,
and you can click it to view and edit a report’s layout and underlying query.

Combined Query

Right-click a report, and choose Modify to edit the report. Select the Data Access tab, and on the Data Providers sub-tab,
click Edit (available only to Developer users), to open the Query Panel and show the report’s building blocks, (as shown in
Cutaway of the Query Panel for the Agent Not Ready Reason Code Report).

Most GI2 reports display the results of two queries, Main Query and Date Range Query. However, in order to achieve a
particular end result, a few reports incorporate a third (or fourth) query. Two reports—the Interaction Volume Service Type
Trend and the Agent Details Activity reports—use a combined query, as shown in the figure Combined Query.

If you have to customize reports, make sure that you are working with the correct query when there is more than one.
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Cutaway of the Query Panel for the Agent Not Ready Reason Code
Report

The figure Cutaway of the Query Panel for the Agent Not Ready Reason Code Report shows the Main Query, the Date Range
Query, and the Total Not Ready Query of the Agent Not Ready Reason Code Report. Other reports that make use of three or
more queries include the following:

• Agent Conduct Report
• Agent Interval Based Report
• Agent Not Ready Reason Code Report
• Agent Summary Activity Report
• Agent Wrap Report
• Business Metrics Executive Report
• Interaction Volume Summary Report

Summary Tabs

Summary Tab of the Interaction Volume Service Type Report

Understanding Reports and Workspaces Licensing Restrictions
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Many reports include one or more Summary tabs that highlight exceptional events that occur within your contact center or
enterprise. Depending on the report, these exceptions might be highlighted in one or more colors to enable you to focus
quickly on highly productive or problematic areas.

The figure Summary Tab of the Interaction Volume Service Type Report shows sample data on the Summary tab of the
Interaction Volume Service Type Report. With the exception of the Interaction Flow Report, none of the detail reports (found in
the Details folder) include a Summary tab.

• [+] What Zero Signifies
Whenever the underlying query for a GI2 report returns no rows, the report displays no data. For example, a query to retrieve
activity for a particular agent for a shift that the agent did not work returns no data. On rare occasions, Web Intelligence returns
the message No data to retrieve in Main Query.

Zero Values in the Speed of Accept Report

For those GI2 reports that do return rows, but in which a particular field is not applicable, the reports return a value of 0. For
example, suppose that all interactions for a particular day were accepted within the first four service time intervals that were
defined for a tenant, but none were accepted beyond the fourth interval. As a result, the Speed of Accept (seconds) Report—a
portion of which is shown in the figure Zero Values in the Speed of Accept Report—displays 0 values for the each of the fifth
through tenth intervals.

The reports also return 0 for measures when the underlying database columns on which measures are based hold 0 values.
Additionally, when a report is based on a query that gathers data from more than one aggregation table, empty cells in reports
are possible where other cells contain data.

For composite measures, such as percentages and averages, wherever a 0 count or 0 duration ensues, the reports display 0 for
such measures. The average duration of calls placed on hold, for instance, is 0 in the circumstances where either no calls were
placed on hold during the interval, or where the duration of held calls was 0 seconds (or a fraction of 1 second).

The custom reports that you create might behave differently depending on their design. Refer to BO/BI documentation for further
information.

• [+] Printing Reports
GI2 reports are optimized for onscreen viewing, though where possible they are also designed to be legible when printed.

Some of the charts and tables that are presented on the Summary tabs of reports use background colors (for example, green,
red, and yellow) to summarize the information that is provided in the main report tab; these colors might be difficult to
differentiate when the report is printed to a black-and white printer.

Printing most reports requires tabloid-size paper (11"x17") and most reports are output with landscape orientation. Reports that
contain a lot of data, such as the Queue Summary and Agent Utilization reports, encroach the minimum margin space that is
required for some printers. If you find that your printed output is cropped at the margins, consider scaling down the report output
to satisfy the minimum allowable margins for your printer. Typically, you can accomplish this either by adjusting the settings in
the Print dialog box of your printer driver, or through the Print Setup or Page Setup menu items of the software application of
the report output. As well, you can scale output with some of the supported BI output formats. Consult the software
documentation of your targeted output format to learn about its ability to scale, as well as the hardware documentation for your
specific printer for information about the minimum margin widths.

• [+] Personalizing Report Instances
Using the built-in features of BO, you can publish reports in a manner that limits the dataset that is exposed to report viewers
when they open a report instance. Do this by personalizing the dataset to a dynamic profile that is defined in the Central
Management Console (CMC).
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Tip
In addition to (or instead of) using the method described in this section, you can restrict user access to data
using integrated, role-based Data Access Restrictions, described in the Genesys Interactive Insights
Deployment Guide.

Use the following procedures to personalize BI reports, restrict data access, and send reports (containing the selected data) by
email.

1. Creating a Dynamic Profile Within CMS.

The task of personalizing report instances begins
with the creation of one user profile within the
Central Management Server (CMS). Profiles work
in conjunction with publications to personalize
the content that users see. This sample profile
will be dynamic—classifying users and groups,
based on the user name that is issued to log in
to BI LaunchPad. However, you can create other
types of profiles that are based on other
variables or on one or more fixed values.

To create a dynamic profile, perform the following steps:

1. Log in to CMC as an Administrator, and select
Profiles.

Setting a Dynamic Profile Value

2. Click Manage > New > New Profile.
3. Enter a title and (optionally) a description for

the new profile, and click OK.
4. Open the profile and add a new profile value:

a. Select Profile Values.
b. Click Add, and then click Choose (next to

User or Group).
c. Select the targets of your publication from

the list on the left, move them to the
right, and then click OK.

d. From the Add Placeholder list box,
select Title.
CMC autofills the New value field with a
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variable: %USER.SI_NAME%.
e. Click Add to move this value to the

Existing values list, as shown in the
figure Setting a Dynamic Profile Value.

f. Click OK, and then click Close to close
the profile.

Creating this dynamic profile enables you to concentrate
configuration refinements to one BI object; you do not have
to configure data-restriction rules individually for each
recipient. Next, you must apply the profile to a publication
that is distributed to report-viewer recipients. Refer to
“Managing Profiles” in the relevant SAP Administrator's Guide
for more information about creating profiles (see BO/BI
documentation).

2. Applying the Profile to a Publication

The next step is to create a publication.
Continuing with the example shown in Step 1.
Creating a Dynamic Profile Within CMS, this step
shows you how to create the Agent Conduct
Publication, which uses the Agent Conduct
Report as the source document. To this
publication, you add the BOE User Account
profile that was created earlier. Finally, you
schedule the publication for distribution to all
Interactive Insights report viewers.
1. Create a publication that points to a WebI

report as the source document:
a. Within BI LaunchPad, click New >

Publication.
b. In the Title field, enter Agent Conduct

Publication.
c. Click Source Documents, then click

Add. Select the Agent Conduct Report as
the source document, and click Save and
Close.

Assigning a Local Profile to a Publication

2. Open and modify the publication’s properties
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to associate with it the previously created
profile:
a. Double-click the new publication to open

the Properties.
b. From the list of Properties, select

Personalization.
c. In the Local Profiles section, from the

Report Field list box, select a value that
will serve as the filter. The figure
Assigning a Local Profile to a Publication
shows the Agent Name field from the
report’s Agent query selected for this
option. The Enterprise Recipient
Mapping list box appears.

d. From the Enterprise Recipient
Mapping list box, select the profile you
created previously (in Step 1. Creating a
Dynamic Profile Within CMS).

e. Click Destinations and choose
notification options (for example, select
Email to send the report by email, and in
the Show options for selected
destinations list box, choose Email, and
set appropriate options.).

f. Click Recurrence, and from the Run
Object list box, choose how often to send
the notification (for example, select Daily
to send it once per day).

g. Click OK to save your changes.
Note that, unlike most other Interactive Insights reports,
the Agent Conduct Report is built from the unified results
of two queries. Most other reports are built from one
query.

Refer to the relevant SAP Publisher’s Guide for more
information about creating and scheduling publications (see
BO/BI documentation).

3. Modifying the Agent Name Dimension

The final step in personalizing a report is to
modify the Agent Name Dimension. If you
followed the example in Step 1: Creating a
Dynamic Profile Within CMS, you defined a filter
that is associated with BI account names (a
dynamic profile, which changes according to the
manner in which the user logs into BI
LaunchPad). This filter limits the data that is
exposed to users. As packaged, however, no GI2
report contains any object that directly
correlates to BI account names. To complete this
example, therefore, you must tailor one universe
object to synchronize it with BI user account
names, which ensures that users see only data
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from their own dataset.
The User Name detail dimension is the closest universe object
that can be associated with a BI account name. This requires
that you configure BI user names in the same manner in
which users are configured within Genesys Configuration
Server. In the 8.5 release, however, no GI2 reports employ
the User Name detail dimension in their design; the Agent
Name dimension is used instead. Agent Name is a composite
entity comprised of three components when their values are
not null:

• Last Name
• First Name
• Resource Name

There are three solutions from which you can choose:

• Modify all of the reports to substitute User
Name for Agent Name, modify the report
layouts that section and filter on this
dimension, and conduct testing.

• Add the User Name detail to the query and
layout of those reports wherever the Agent
Name dimension appears.

• Alter the definition of the Agent Name
dimension in the few classes where it exists.

This example uses the third option. To modify the Agent Name
definition:

1. Open the Information Design Tool and
navigate to the Agent\Activity class.

2. Open the properties of the Agent Name
dimension, clear the WHERE clause, and
change the Select statement to the
following:
@Select(Activity\User Name)
Or, mimic the User Name detail definition:
RESOURCE_GI2.RESOURCE_NAME

3. Save the definition by clicking OK.
4. Repeat this modification for all other Agent

Name dimensions that exist throughout the
universe.

5. Save the universe and export the changes
back to the repository.

6. Test by running agent-related reports and
comparing results to expectations.

Subsequently, when a BI user opens a report instance that
was distributed by the publication, the results that the user
sees are limited to only those records in which Agent Name is
equivalent to the name of the user’s own BI user account.

Limitations of personalization The following limitations apply:

Understanding Reports and Workspaces Licensing Restrictions

Genesys Interactive Insights User's Guide 19



Profiles filter the view of a document’s content; profiles do not
restrict the data that is being queried from the data source
nor do they control users’ access to data. If users have the
appropriate rights to access documents in their original
format, they can see the document’s entire dataset. Altering
the definition of the Agent Name dimension—or replacing
this dimension altogether within the reports—is neither
supported nor tested by Genesys Quality Assurance.
Subsequent redesign and testing can be extensive,
depending on the option that you choose to associate
contact center objects with BI objects. Genesys has not
assessed the full impact of such changes, such as the
continued functionality of drill-down/drill-up operations.

For additional information about working with reports, see the section Working With Reports in Web
Intelligence.
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Working With Reports in Web Intelligence
This section helps you work with reports in Web Intelligence. This section contains the following
topics:

Using the Prompts

Each GI2 report contains several user prompts that filter the data that the report will retrieve (see the
User Prompt Input area). The values specified at these prompts apply to all tabs of the report. If
you clear the default specifications for these prompts without providing new values, you will not be
able to run the report.

Hour Prompts

For the hourly reports, you must restrict your
specification of hours to a range within one
calendar day.
[+] More Information
For instance, if a shift operates from 9:00 PM of one day to 3:00
AM of the next day, the results can not appear within one report.
Instead, run two reports—one from 9:00–11:59 PM of one day
and the other report from 12:00–3:00 AM of the next day.
Alternatively, you can customize the day-range prompts for the
report to recognize hours.

Date Prompts

With the exception of the detail reports, BI
LaunchPad and Web Intelligence ignore the time
component of date prompts.
[+] More Information

BI software Ignores the Time Component
of Start and End Date Prompts

This is common in the Start Date, End Date, and Report
Date prompts of GI2 reports. Thus, if you select a specific time
in conjunction with a specific date, the GI2 reports ignore the
time and use only the specified date. The figure BI software
Ignores the Time Component of Start and End Date Prompts
highlights the time component that automatically appears with
all date settings. Regardless of the time that appears in the
prompts, GI2 uses the following times:

• 12:00:00 AM as the start time for all dates that
are specified under Start Date

• 11:59:59 PM as the end time for all dates that
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are specified under End Date—even though
12:00:00 AM appears in this field

So, to run a report for one day—for example, for November 30,
2014—you would designate the following:

• 11/30/2014 12:00:00 AM for the Start Date
prompt (or any other time value)

• 11/30/2014 12:00:00 AM for the End Date
prompt (or any other time value)

where these user prompts appear in the reports. Even though
start and end appear to be the same moment in time, the report
actually spans 24 hours. For the detail reports, the Start Time
and End Time user prompts actually do recognize the time
values that you designate, and you must indicate an appropriate
time value along with a date.

Troubleshooting Date Prompts
When you select Date from a Calendar, BI can sometimes return
the previous day’s date. If this happens, you can correct the
problem by setting the time zone to Coordinated Universal Time
(UTC), using one of the following procedures:

For Microsoft Windows:

1. On the Microsoft Windows system where Tomcat
is installed, open the Tomcat program group
and select Tomcat Configuration.

2. In the Tomcat Configuration window, click the
Java tab.

3. Under Java Options, append the parameter
-Duser.timezone=utc.
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Preset Date Prompts

For Linux:

1. Log in to the Linux account where BI software is
running, and open .bash_profile for editing.

2. Add the following rows to the .bash_profile file:
TZ=utc
export TZ

3. Save the file, and restart Linux.

Preset Date Prompts
Each GI2 report also includes one preset date prompt (from the
list in the figure Preset Date Prompts) that enables you to
specify one date range—relative to the current date—in which to
run reports.

The preset dates that are available to you can vary from report
to report. With the exception of the Today and the ...to Date
preset dates, all preset dates exclude information that has been
gathered about the current day. GI2 reports use the value that is
specified in the preset date field over any other dates that are
specified in the report’s Start Date, End Date, and/or Report
Date fields. For a report to recognize these other fields, you
must set the preset date to None.

Free-Text Prompts User prompts in some reports require that you type
in values instead of selecting from a list.
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[+] More Information
The Interaction Handling Attempt Report, for example, contains
the following free-text prompts:

• Customer ID
• From
• To
• Interaction ID

The values that you supply in these fields must match exactly
the values that are to be retrieved from your data source. Wild-
card characters and operators (such as ‹ and ›) are not
recognized. To specify more than one value in a field, separate
each value with a semicolon (;)—for example:
4155551234;5066746767;6504662829
To have Web Intelligence retrieve all values for these fields
(satisfying the report’s other conditions):

• Type 0 in number-based free-text fields, such as
Interaction ID.

• Type ALL in character-based free-text fields,
such as Customer ID.

Running a report with these fields cleared will cause Web
Intelligence to display a dialog box that prompts you to specify
the missing values.

Prompt Interrelationships

With the exception of the Interaction Flow report,
there are no interrelationships between the user
prompts in GI2 reports, by default.
[+] More Information
(You can add interrelationships by customizing the reports to
use cascading prompts, as described in Using Cascading
Prompts.) From the perspective of BI LaunchPad or Web
Intelligence, the selections that you make at one prompt are
independent of the selections that you make at another.
Although relationships between objects might be well defined
within your data source, selecting a particular queue group from
the Queue Group prompt, for instance, does not restrict the
queues that are available at the Queue prompt to only those
that belong to the selected queue group. Therefore, take care to
make meaningful selections at all prompts.

For the Interaction Flow report, the selections that you make at
the Target Agent and Target Queue prompts are
interdependent. Select ALL targeted queues, for instance, to
return all interactions (meeting the report’s other qualifications)
that pass through any queue that is associated with the
indicated agent at the Target Agent prompt, and vice versa. In
addition, although the values you select at other prompts in this
report are independent—bearing no relationship to each
another—the report will retrieve all legs of an interaction in
which the criteria that you specify indicate to retrieve fewer
than the entire life of the interaction.

Many of the reports have more than one date prompt, including
Pre-set Date Filter, Pre-set Day Filter, Start Date, and End
Date prompts. Know that the selection that is specified in the
Pre-set Date Filter or Pre-set Day Filter trumps any other
date specification that you make. Also, if your preset date
selection is set to a date for which there is no data in your data
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mart, your report will return no results, regardless of any range
of dates that you might have specified in the Start Date and
End Date user prompts. For the report to recognize the values
that you specify for Start Date and End Date, you must
explicitly set the Pre-set Date Filter (or Pre-set Day Filter)
prompt to None. Web Intelligence does not validate for
meaningless input at the user prompts, such as end dates that
fall before start dates.

Drilling Up and Drilling Down

The ability to drill up and drill down within a report to view results from a wider or narrower
perspective is available through Web Intelligence. This feature is controlled by the ordering of
dimensions in the hierarchies that are defined using the Information Design Tool.

[+] Show Table: Hierarchies Inherent within GI2_Universe

Time Interval hierarchy: Year > Quarter > Month > Day > Hour > 30
minutes

Service Type hierarchy: Service Type > Service Subtype
Agent hierarchy: Agent Group > Agent Name
Campaign Group hierarchy: Campaign Group > Campaign
Queue hierarchy: Queue Group > Queue
Interaction hierarchy: Interaction Type > Interaction Subtype

Tip
The hierarchies in the Information Design Tool differ from those that are used for
aggregation of Info Mart data, which are described in the Reporting and Analytics
Aggregates User’s Guide.

Drilling along the Campaign Group Hierarchy
Drill operations along the Campaign Group hierarchy can result in the display of duplicate rows in a
report when agents belong to more than one agent group.
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Drilling Anomaly When Agents Belong to more than
one Group

When agent-campaign results are displayed, drilling down from campaign to campaign group and
then drilling up from agent to agent group results in duplicate rows. The figure Drilling Anomaly When
Agents Belong to more than one Group demonstrates this anomaly in three cutaway illustrations of
the Agent Outbound Campaign Report.

Drill-Up Operations
Drill-up operations display results based on the criteria that you originally specify. For example,
drilling up from a daily report instance that spans two days provides results for only the two days
selected for the new report instance, which, according to the Time Interval hierarchy, is aggregated
by month. Further drill-up from the one-month report instance provides partial quarter
results—containing data only for those originally selected two days. The same is true if you drill-up to
a year report. Reverse drilling also respects the original selection criteria.

Drill-Down Operations
You cannot drill down from aggregated results to the interaction- or interaction-segment level;
however, the relevant data is available in the Info Mart database (if it has not been purged), and you
can create reports to provide this level of detail. (The Interaction Detail reports provide interaction-
and interaction-segment levels of detail without drilling from aggregated information.) The previously
referenced Interaction hierarchy is based on an interaction’s type and subtype (for example,
Inbound/InboundNew), not on the legs of the interaction.

Refreshing Data

You should refresh report data whenever the aggregation process completes and prior to first opening
the report. Indeed, for that report to display any results, you must refresh the data upon opening a
report that has never been previously opened at all. The process of opening a report, in and of itself,
does not refresh the report’s data.
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Refreshing the report’s data is important if the report was previously saved with its results; if the data
is not refreshed, Web Intelligence uses instead the data that is saved within the report’s cube, which
might contain outdated data. (Refer to BusinessObjects documentation for information about the
content of report cubes.) You must also refresh a report upon drill when the report contains smart
measures—measures whose aggregation function is Database delegated. By design, instead of the
cell’s value, Web Intelligence, displays #TOREFRESH as a place-holder until the report is refreshed.

To refresh a report’s data, click Refresh Data. The Web Intelligence status bar reflects the last date
and time when the report was refreshed. If a report has never been refreshed, the Status bar displays
the following message:
Refresh Date: Data is not refreshed.

The aggregation process runs continuously throughout the day within the time frame that is
determined by configuration options in the [schedule] section of the Genesys Info Mart Application
object. Refer to the Genesys Interactive Insights Deployment Guide for information about these
options, and to determine the schedule setting in your environment.

Tip
When aggregation values are not available at the time that a query is run, delegated
measures can return #TOREFRESH values in some reports. To prevent this, you can
enable an automatic refresh option either on the server, or on a per-document basis.
For more information, see the Genesys Interactive Insights Release Note.

For additional information about Web Intelligence, refer to the BO/BI documentation.
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Understanding the Universe
This section provides general information about the GI2 Universe, and helps you understand how to
use the Information Design Tool.
The universe for GI2 consists of the following elements:

• nearly 600 measures
• 60 conditions (otherwise known as filters)
• several queue, agent, and time-related dimensions
• hierarchies
• lists of values
• hidden elements

You organize and manage these elements using the Information Design Tool (see the figure The
Information Design Tool). Note, however, that if your universe uses the BOE 3.1 UNV format, you
must manage it using the Universe Design Tool.

[+] More Information
Most of the elements used by the GI2 reports are defined in the universe. Other elements—such as
the labels, the page footer, column headers, and a portion of report headers—are defined in the
report structure using Web Intelligence. Note that there are many universe elements that are not
used in any report. The Genesys Interactive Insights Universe Guide describes each element and the
reports that rely on them.

Universe restructuring should be performed only by users who possess a profound understanding of
Info Mart tables and columns and commensurate knowledge of BI software. Genesys does not
support modifications to universe elements beyond those customizations described in Customizing
the GI2 Universe and Reports. Because universe elements serve as the semantic layer for all users,
Genesys recommends that you do not allow your general user population to modify universe
elements. For information about controlling the rights of GI2 (BO) users, see the BO/BI
Documentation.
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The Information Design Tool

The GI2 Universe in the Information Design Tool

The GI2 Universe in the Information Design Tool

The elements within the GI2 universe constitute the business-friendly semantic layer of Genesys Info
Mart.

[+] More Information
This universe contains:

• Predefined SQL-based objects that map to SQL structures (tables, columns, database functions) in the
Info Mart database.

• A schema of the tables and joins that are used in the Info Mart.

The Information Design Tool is the BusinessObjects tool that was used to define this layer and the tool
that you can use (if your account has the appropriate rights) to:

• Modify the objects to affect which results are retrieved by the GI2 reports.
• Create new universe objects (or universes) for use in Web Intelligence reports.
• See the extended definitions of objects that belong to the GI2 universe. (Basic descriptions of measures

are visible to all users in the BI LaunchPad and Web Intelligence interfaces.)
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• Specify connection parameters to one or more database middleware.

Through Web Intelligence, report users connect seamlessly to the GI2 universe and run queries
against their data mart. Report users can perform data analysis and create new reports, choosing
objects from the GI2 universe, without ever seeing or having to understand the complex queries or
data structures of their underlying data mart.

Supported Alternate Definitions of the % Accepted
Measure

For instructions on how to use this component, refer to the Information Design Tool User Guide
available from SAP. Certain modifications to universe elements are supported; these are indicated in
the description of a particular measure in the Genesys Interactive Insights Universe Guide. In
addition, if alternate definitions exist, they are provided in the measure’s properties on the Source
Information tab, which is shown in the figure Supported Alternate Definitions of the % Accepted
Measure. In the Information Design Tool, supported alternate definitions begin with the phrase
“Developer use only”. (You might have to scroll to read all of the alternate definitions.) Refer to
Customizing Measure Definitions for the preferred procedure for changing these definitions.

For more information about the universe, see the following pages:

• Measure Names
• Classification of Measures
• Available Media Types
• Source of Aggregated Information
• Measure Maps
• Media-Neutral Measure Mapping
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Measure Names
Use the information on this page to understand measure naming and reference metric IDs.

Reference Metric ID

Reference Metric ID of the Queue\Entered Measure

Many classes contain measures with names that match measures in other classes. However, the full
name of a measure includes the class in which the measure belongs, which thereby makes it unique.
Because the full name can be quite long, most measures have been assigned a reference metric ID
which appears on the Source Information tab of the measure’s properties. This ID is informational
only and is not referenced by any of the reports. Should you need to contact Genesys Customer Care
for assistance, this ID might be useful when you are describing a particular measure.

The figure Reference Metric ID of the Queue\Entered Measure shows the ID that is assigned to the
Entered measure that belongs to the Q Customer class in GI2_Universe. By contrast, the reference ID
of the like-named measure in the BA Customer class is T_ENTERED.

Naming Convention

Detail measures are sourced from the following Genesys Info Mart tables:

• SM_RES_STATE_FACT
• SM_RES_STATE_REASON_FACT
• MEDIATION_SEGMENT_FACT
• INTERACTION_RESOURCE_FACT

All interval measures are sourced from aggregation tables that contain "_I_" in the database object
name—for example:

• AG2_I_AGENT_SUBHR
• AG2_I_STATE_RSN_SUBHR
• AG2_I_SESS_STATE_SUBHR
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No special naming convention identifies a table as one that contains disposition measures, other than
disposition measures are all sourced from AG2_* tables that do not to use "_I_" in the table name—for
instance:

• AG2_AGENT_CAMPAIGN_HOUR
• AG2_AGENT_QUEUE_HOUR
• AG2_CAMPAIGN_HOUR
• AG2_QUEUE_HOUR
• AG2_QUEUE_ABN_HOUR
• AG2_QUEUE_ACC_AGENT_HOUR
• AG2_QUEUE_GRP_HOUR
• AG2_ID_HOUR
• AG2_AGENT_HOUR
• AG2_AGENT_GRP_HOUR

Each hierarchy contains seven tables and/or views, which have the following suffixes: _SUBHR,
_HOUR, _DAY, _WEEK, _MONTH, _QRTR, and _YEAR.
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Classification of Measures
All measures are classified as one of three types:

• Detail
• Interval
• Disposition

The Genesys Interactive Insights Universe Guide identifies each measure’s classification. Measures
can also be described as measuring either customer or consult interactions, and for consult
interactions, as either warm or simple consultations. The following subsections describe each of
these classifications.

Detail Measures

Detail measures provide the measure of one and only one activity, in contrast to interval and
disposition measures, which aggregate information about a number of interactions that occur over a
period of time. Some examples of detail measures include the following:

• Flow\Duration
• Session\Active Time
• State\Reason Time
• Ixn State\Duration
• Handling Attempt\Queue Time
• Flow User Data Example\Detail 8

• Handling User Data Example\Detail 16

(Flow User Data Example\Detail 8 and Handling User Data Example\Detail 16 are hidden universe
measures that appear in italic font both in this document and in the Information Design Tool.) Note
the distinction between these detail measures and BO’s terminology for Detail objects—such as the
User Name detail object of the Agent Name dimension. The two concepts are entirely different.

Interval Measures

Interval measures measure the activities occurring within the reporting interval as they occur,
regardless of whether or not the interactions complete during the interval and whether or not the
interval completes.

Counts and durations of such measures are clipped where interactions cross over multiple intervals
and are attributed to each of the intervals in which the activities occur. In scenarios in which an
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interaction is waiting in queue when the hour changes, the time that the interaction actually waited
in queue during the first interval is attributed to the first interval. For example, if an interaction is
waiting in queue from 3:58–4:03 PM, two minutes is attributed to the first interval (3:30–3:59 PM),
and the remaining three minutes is attributed to the second interval (4:00–4:29 PM).

Furthermore, a count is attributed to each interval in which the interaction persists—that is, a count
of 1 for the interaction that is waiting in queue during the first interval, and another count of 1 for the
same interaction, waiting in queue, during the second interval.

Interval measures provide an interpretation of the activity that occurred during an interval. Some
examples of interval measures include the following:

• Interaction State\Consult Received Time
• Interaction State\Hold
• Summarized State\Active Time
• Summarized State\Busy

The Ixn State class in the GI2 universe houses additional interval measures.

Disposition Measures

Disposition measures provide an interpretation of the count and duration of contact center activity,
attributing their measure to the interval in which an interaction was received by the contact-center
resource—whether the resource is a mediation DN or a handling resource, such as an agent. In
scenarios in which an agent talks to a customer over day boundaries, all of the talk time is attributed
to the first reporting interval and no time is attributed to the latter interval. For example, if an agent
talks to a customer over day boundaries (11:45 PM –12:15 AM), all of the talk time (30 minutes) is
attributed to the first reporting interval (Day 1) and no time is attributed to the latter interval(s) (Day
2).

Likewise, the count (of 1 interaction) gets attributed to the first interval; no count at all gets
attributed to the second. As such, disposition measures are additive; their counts from one interval
can be added to the counts of other intervals to obtain a total count of activity across all intervals,
without double counting.

The following are examples of disposition measures:

• Activity\Avg Consult Received Time
• BA Customer\% Transfer Initiated Agent
• Q Customer\Hold
• Agent Contact\Preview

Special Note about Campaign Disposition Measures
For measures that are associated with outbound campaigns, counts and durations are attributed to
the interval in which contact attempts were made. This differs from prior releases, in which such
measures were attributed to the interval in which the outbound campaign group session was started.
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Customer versus Consult Interactions

The GI2 universe contains objects that measure only the customer-related legs of interactions or the
consultation-related legs of interactions—described as customer interaction and consult interaction,
respectively, within GI2 documentation. These terms are defined in the “Dictionary of Data Elements”
appendix of the Genesys Interactive Insights Universe Guide. This distinction enables you to create
reports that summarize activities that better align with a contact center’s core business.

Some universe measures mix together these different parts of an interaction’s life cycle—most
predominantly, those that are in the Q Customer & Consults class. Some measures co-mingle
customer interactions with a subset of consult interactions, or warm consultations (discussed in the
Genesys Interactive Insights Universe Guide.)

The following table summarizes whether measures in each universe class incorporate customer-
related activity or consultation-related activity; and, if the latter, what type of consultation activity is
measured therein. A few universe measures are related neither to customer nor consultation activity;
this is indicated in the N/A column. (The Bound measures in the Service Objects class, for example,
do not measure contact center activity; they are provided in an administrative capacity for the
derivation of other measures.): <toggledisplay showtext="[+] Show Table: Customer vs. Consult
Interactions in the Universe" hidetext="[-] Hide Table: Customer vs. Consult Interactions in the
Universe">

Class\
Measure Customer Simple

Consult
Warm

Consult
Warm &
Simple N/A

Abandoned
Waiting STI
class\*

* *

Accepted
Agent STI
class\*

*

Activity class:
All Consult
Warm
measures

*

Activity class:
All other
Consult
measures

*

Activity class:
All Accepted,
Offered,
Responses
measures

* *

Activity class:
Handle * *

Activity class:
All other
measures

*

Agent Contact
class: All
Consult Warm

*
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Class\
Measure Customer Simple

Consult
Warm

Consult
Warm &
Simple N/A

measures
Agent Contact
class: All other
Consult
measures

*

Agent Contact
class: All other
measures

*

BA Consults
class: All
Consult Warm
measures

*

BA Consults
class: All other
Consult
measures

*

BA Customer
class\*: All
Accepted
measures

* *

BA Customer
class\*: All
other
measures

*

Queue\Q
Consults class:
All Consult
Warm
measures

*

Queue\Q
Consults class:
All other
Consult
measures

*

Contact
Attempt class\* *

Queue\Q
Customer
class: All
Accepted
measures
(but not the Accept
measures)

* *

Queue\Q
Customer
class: All
Entered,
Distribute(d),

* *
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Class\
Measure Customer Simple

Consult
Warm

Consult
Warm &
Simple N/A

and Offered
measures
Queue\Q
Customer
class: All other
measures

*

Queue\Q
Customer &
Consults
class\*

* *

Flow class\
Duration * *

Handling
Attempt class:
All Customer
measures

*

Handling
Attempt class:
All Conference
measures

*

Handling
Attempt class:
Revenue,
Satisfaction

* *

Handling
Attempt class:
Queue Time,
Response
Time, Routing
Point Time, and
Total Duration
measures

* *

Interaction
State class * *

Ixn State
class\* * *

Service Objects
class\* *

Session class\* * *
State class\* * *
State and
Reason class\* * *

Summarized
State class\* * *

Transfer class\* *
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Available Media Types
The Genesys Interactive Insights Universe Guide lists which media types can yield results different
from zero for each measure in the universe. For example, the available media types for the Consult
Standard Abandoned Waiting measure in the Q Consults class is described as "Voice, Open (Sync)",
indicating that voice and all open synchronous media types are available.

The following table summarizes the applicable media types for groupings of measures across all of
the classes in which they are found. “All Abandon measures”, for instance, applies to all of those that
measure the abandonment of interactions, whether they be consultations that were abandoned,
abandoned inviting and waiting measures, short-abandoned measures, standard abandons, or
abandoned-within-a-service-time-interval measures including durations, counts, maximums,
averages, and percentages thereof:

[+] Applicable Media Types Within the Universe
Voice Media Sync Media All Media N/A

All Abandon
measures X

All Accepted/Not
Accepted
measures

X

All Active Time
measures X

All Bound
measures and Is
Current Data

X

All Busy measures X
All Clear measures X
All Conference
measures X

All Consult
measures X

All Dial measures X
All Distributed
measures X

All Duration
measures (not to
be confused with
all measures that
measure duration)

X

All Engage
measures X

All Entered
measures X

All Finish measures X
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Voice Media Sync Media All Media N/A
All Handle
measures X

All Hold measures X
All Invite measures X
All Offered
measures X

All Outbound
measures X

All Ready/Not
Ready/Occupancy
measures

X

All Redirected
measures X

All Rejected
measures X

All Response, No
Response, and
Responded
measures

X

All Revenue and
Satisfaction
measures

X

All Routed Other
measures X

All Skill measures X
All Stuck measures X
All Transfer
measures X

All Unknown
measures X

All Warm measures X
All Wrap measures X

Where the listed applicable media types for a particular measure within the group differs from the
norm, the differences are footnoted at the bottom of the table. For those measures that can be
classified as belonging to more than one grouping (that is, represented by two or more rows in the
table), the most restrictive media-type rule applies.

For example, the Consult Received Warm Wrap Time measure can be classified under:

• “All Consult measures”, which apply to all but Chat media.
• “All Warm measures”, which apply only to Voice media.
• “All Wrap measures”, which apply only to Voice media.

The last two media rules are the most restrictive of the three; therefore, they apply to the Consult
Received Warm Wrap Time measure.
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Source of Aggregated Information
The tables that are created and populated by the aggregation engine are the immediate source of
aggregated contact center data for GI2 reports. This engine is deployed seamlessly with GI2
installations, and is described in the RAA documentation. The reports are built on data from these
tables,and enable you to view the performance of contact center resources as interactions pass
through the resources or are handled by them, dimensioned by the following Info Mart dimension
tables:

• CALLING_LIST
• CAMPAIGN
• DATE_TIME
• RESOURCE_
• RESOURCE_GROUP_COMBINATION
• GROUP_
• MEDIA_TYPE

• USER_DATA_CUST_DIM
• TENANT
• TIME_RANGE
• INTERACTION_TYPE
• INTERACTION_DESCRIPTOR
• RESOURCE_STATE
• RESOURCE_STATE_REASON

The “Interactive Insights Reports” chapter of the Genesys Interactive Insights Universe Guide lists the
supporting tables for each report and some of the configuration options that control the Genesys Info
Mart Server’s population of the tables. Also, the Reporting and Analytics Aggregates User’s Guide
provides business views of each aggregate subject area. See the Genesys Info Mart User’s Guide to
learn how data is populated to the Info Mart database.
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Measure Maps
Several measure maps that illustrate the relationships among measures in the universe are available
in the Documentation folder in BI LaunchPad. The same folder contains the Genesys Interactive
Insights Universe Guide, this User’s Guide, and a graphic illustrating the synchronicity of interactions.
The measure maps that are available include the following:

The Business Attribute
(1 of 2) Measure Map

• Agent Activity
• Agent Activity – Interaction State
• Agent Activity – Summarized State
• Business Attribute 1 of 2
• Business Attribute 2 of 2

• Agent Contact
• Contact Attempt
• Queue 1 of 2
• Queue 2 of 2

The figure The Business Attribute (1 of 2) Measure Map shows one of the two Business Attribute
measure maps.
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Media-Neutral Measure Mapping
GI2 reports internal and outbound interactions (in addition to inbound interactions) across chat and
email media channels (in addition to the voice channel). In order for measures to apply to media
other than voice media, the GI2 language uses media-neutral object names instead of replicating like
measures and assigning them media-identifying names. You might be accustomed to viewing results
that use voice-centric terminology, especially if your contact center monitors voice-only interactions.
For example, while "Avg Engage Time" describes the average length of an active telephone
conversation, the meaning of "Avg Talk Time" is more immediately understood.

• The following table facilitates this transition to media-neutral terminology by providing a mapping of
industry-common terms to the names of GI2’s media-neutral measures:
[+] Mapping Media-Neutral Measures to Voice Terminology

Voice-Centric Term Media-Neutral Term in GI2
Abandoned while Ringing Abandoned Inviting
ACW (after-call work) Wrap

Answer
Accept (for Chat)
Response (for E-mail)

Answered in Threshold Accepted in Threshold
ASA (Average Speed of Answer) Average Accept Time
Dialing Inviting or Invite
Login Time Active Time

Ringing
Alerting or Alert
Inviting or Invite (Both Ringing and Dialing constitute Inviting
measures.)

Talk Engage

• The following table illustrates how Genesys Info Mart prescribes some media-neutral states to
interactions that differ slightly from how GI2 reflects interaction (ixn) states in the names of some
measures:
[+] Mapping of Genesys Info Mart Ixn States to GI2 Ixn States

Genesys Info Mart Classification GI2 Classification

Initiate This is reflected in the Dialing component of
Inviting measures.

Alert Alerting. This is reflected in the Alerting
component of Inviting measures.

Connect Engaged.
Hold Hold.
Wrap Wrap.
Unknown Unknown.

This difference is most visible in data that is retrieved by the Agent Details Activity Report. For online media, for example, the
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report reports the state of an interaction as connected (Connect), whereas you might otherwise expect to see it classified as
Engaged. Read more about Genesys Info Mart’s classification of interaction states in the relevant reference manual (available in
the Genesys Info Mart documentation set); they are described under the INTERACTION_RESOURCE_STATE table.
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Customizing the GI2 Universe and Reports
This section provides general guidelines for how to customize the GI2 universe and reports to achieve
additional functionality. Emphasis is placed on customizing a copy of the reports and/or making a
copy of the universe.

BI software does not maintain older versions of reports, and once you save changes to a report and
export universe elements to the repository, you cannot restore the previous version.

After you have customized definitions in the universe, remember that you must save the universe
and export it back to the BI repository so that your changes are made available to report users, using
the procedure described in the "Linking the Universe to Your Data Mart > Publishing the Universe
Back to the Repository" section of the Genesys Interactive Insights Deployment Guide.

Warning
Carefully design and implement all Universe customizations, and test them fully in
your own environment before placing them into production. Genesys does not support
the implementation of the procedures in this chapter other than where explicitly
recommended. Genesys Quality Assurance has not tested these procedures, but
believes that, if you use them as general guidelines, they will enhance your GI2
experience.

For additional information, see the following sections:

• Customizing Measure Definitions
• Distinguishing Same-Named Queues
• Creating Week-Level Reports
• Using 15-Minute Aggregation
• Removing Fields from Reports
• Using Attached Data
• Changing the Forecast
• Using Cascading Prompts
• Reporting Outside the GMT Time Zone
• Setting the Scope of Analysis
• Troubleshooting Incompatibility
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Customizing Measure Definitions
Genesys supports limited customization of the following measures in GI2_Universe:

Activity Class
Avg Handle Time
Handle Time

Queue Class
% Accepted
% Accepted 80
Avg Handle Time
Handle Time

BA Customer Class
% First Response Time
Service Level

Summarized State Class
% Occupancy

Alternate Definition of the Activity\Avg Handle Time
Measure

The supported alternate definitions for each measure are provided in the measure Source
Information properties in the Information Design Tool, as shown in the figure Alternate Definition of
the Activity\Avg Handle Time Measure. Alternate definitions are not provided within the
documentation.

Composite measures are based on the definitions of their supporting measures, which have
definitions that might also be customizable. So, if you customize one definition, be sure to consider
customizing the supported definitions for the entire family of measures that is affected by your
change. Also, keep in mind that some of the measures are used by more than one report; the
Activity\Avg Handle Time measure, for instance, is used by the following seven reports:

• Agent Conduct Report
• Agent Group Business Result Report
• Agent Group Customer Segment Report
• Agent Group Interaction Handling Report
• Agent Group Service Type Report
• Agent Queue Report
• Agent Utilization Report
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Alternate Field, Showing Whether Customization Is
Supported

Changing a measure definition in the Information Design Tool affects all of the reports in which the
measure is used. Refer to the description of each measure in the Genesys Interactive Insights
Universe Guide for a listing of GI2 reports that employ the measure.

To determine if customization for a particular measure is supported, look for the measure in the
Genesys Interactive Insights Universe Guide; in the Universe Guide, the value in the Alternate? field
indicates whether customization is supported (as shown in the figure Alternate Field, Showing
Whether Customization Is Supported which shows part of the Universe Guide entry for the Activity\
Avg Handle Time measure).

How To Change a Measure Definition

1. In the Information Design Tool, click a measure to display the measure properties.
2. Verify that the correct Projection Function is assigned. (The Information Design Tool might reset this

value to Sum when you make certain changes to measures.)
3. On the Source Information tab, copy the appropriate alternate definition from the Technical

Information field. There might be more than one definition from which you can choose.
4. On the SQL Definition tab, replace the definition that is listed in the Select field with the alternate

definition that you copied.
5. In the Description field, edit the measure description to match the definition that you chose.
6. Save and close the universe.
7. Export the universe back to the repository so that the changes that you make are available to all users.
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The Report Description Tab in Web Intelligence

To ensure that report users see accurate descriptions, you must also update measure descriptions, as
appropriate, in the reports in which the customized measures are used. The reports do not inherit
descriptions from the Information Design Tool; you must update them manually. You can find the
descriptions on the Descriptions tab of each report in Web Intelligence, as shown in the figure The
Report Description Tab in Web Intelligence.

You can also create new measures (based on the definitions of existing universe measures) by using
the Formula Toolbar (available when you Modify a report in Web Intelligence). New measures you
create using this method are available only within the Web Intelligence document in which you create
them. In general, Genesys does not recommend this approach to define new measures. Ensure that
only qualified personnel use the custom formula capability.
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Distinguishing Same-Named Queues
This page describes steps you can take to reset dimensions to distinguish queues with matching
names. GI2 expects contact center objects to be uniquely named, and while this is usually true in
single-switch environments, it might not be true in more complex environments that employ more
than one switch. In such scenarios, the names of queue objects could be identical from one switch to
the next.

Because the contact center objects in your enterprise might not have unique names, the queue-
based GI2 reports consider only a queue’s name when retrieving data about queue objects. The
reports do not filter data based on the switch from which the data originated, so queue-based GI2
reports display the results for all queue objects sharing the same name instead of only the results
from the intended queue.

To reset the definition of queue dimensions to recognize the queue’s switch:

[+] Show Steps

Distinguishing Queues

1. Open the GI2 Universe.
2. In the definitions of all Queue dimensions, wherever they occur, replace the SELECT statement with the

following:
{fn concat(RESOURCE_Q.RESOURCE_NAME, {fn concat('@',RESOURCE_Q.SWITCH_NAME)} )}

3. Make similar modifications in other queue-type dimensions, such as Last Queue, Source Last Queue,
and Target Last Queue.

4. Save the universe and test the results.
5. Export the universe back to the repository.

Queue-based reports now display the name of the queue’s switch along with the name of the
queue object instead of displaying only the queue’s name. However, in some cases the
queue@switch values might be too long to fit within the report headers, labels, and table cells
where they might occur. The Interaction Flow Report, for instance, populates the names of queue
objects in tables cells under the Source and Target columns of the report. You can adjust the
layout of this and other reports for better presentation.
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Creating Week-Level Reports
GI2 includes no weekly reports, although the Genesys Info Mart server regularly aggregates and
populates week-level data in the AG2_*_WEEK tables in the Info Mart database. You can use these
tables as the source for week-level GI2 reports that you can create, either:

• Drillable week-level reports
• Week-level-only reports

If you want week-level-only reports without the ability to drill-up or drill-down functionality to the
other aggregation levels, follow the steps in Week-Level-Only Reports to replace the time dimension
that is used in the reports with the Week dimension.

Drillable Week-Level-Reports

For drillable week-level reports, you must do the following:

[+] Show Steps

1. Redefine the Day dimension to be a week-compatible day or create a new day-type dimension
altogether (see Creating a Week-Compatible Day Dimension).

2. Modify the universe Time hierarchy to define one drill path along the desired dimensions (which
includes the Week dimension). Refer to BO/BI documentation for details about editing hierarchies.

3. Replace the time dimension used in the applicable reports with the Week dimension (to create week-
level reports). If, however, you want report users to be able to drill up for week-level results, this step is
not necessary.

BI software enables you to create hierarchies to facilitate multidimensional analysis in the reports.
You can create and maintain two or more time-related hierarchies within one universe, for example:

• 30 minutes > Hour > Day > Week and
• 30 minutes > Hour > Day > Month > Quarter > Year

However, if you create such a sophisticated system, you may experience complications with respect
to performing drill operations in the reports. If hierarchies share the same dimensions, as previously
demonstrated, drill operations become less convenient. No further modification to the reports is
required to enable users to drill up for week-level results. However, you must inform your users of a
week’s boundaries, as they are defined within your data mart. This is discussed in Understanding
Week Boundaries.
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Week-Level-Only Reports

The Week dimension is omitted from the Time hierarchy in GI2 reports, which disables drilling up or
down for week-level results. You can, however, create new copies of some of the reports and
customize them to summarize contact center activity in week-only time buckets. For Week-level-only
reports, you cannot drill along the Time hierarchy. You can enable week-level reporting in all reports
except those reports in the Details folder.

To create Week-Level-Only Reporting:
Customize a copy of a GI2 report as follows:

[+] Show Steps

1. In BI LaunchPad, select the report to copy and customize, then click Organize > Copy, and then
Organize > Paste to create a copy of the report.

2. Select the newly-created copy of the report, and click More Actions > Modify.
3. Edit the report to add the Week dimension to both the report’s query and the report’s layout.
4. (Optional) Edit the prompts to display a selection of dates along week boundaries. This is a complex

task. Alternatively, you can inform your report users of the week boundaries as defined within your
data mart. Refer to Understanding Week Boundaries for information on this topic.

5. Remove any other time dimension from both the report query and its layout.
6. Save the report.
7. Test your changes by running the report and verifying its results.

Creating a Week-Compatible Day Dimension

You must create a week-compatible day dimension if you intend to enable your report users to drill up
from or drill down to day-level results in the reports that you customize. In the default configuration,
the Day dimension in the Time class is a month-compatible day, sourced from the
LABEL_YYYY_MM_DD column of the DATE_TIME table. This field references the particular day with
respect to the month and year in which the day falls; days are consequently numbered as 01 through
31. To reference a particular day within a given week, source the Day dimension from the
CAL_DAY_NUM_IN_WEEK field of this table, which stores the day number of a week—starting with 1
for the first day of the week and ending with 7 for the last day of the week.

To this end, within the Information Design Tool, you can do either of the following:

• Redefine the existing Day dimension. If you choose this method, the new definition affects the results of
all other reports that provide day- and month-level results.

• Create and define a new dimension, such as Day in Week. If you choose this, you must substitute the
new dimension, in both the query panel and report layout, in all reports for which you want to generate
week-level results.
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When you have finished customizing the universe, you must export your work to the BI repository so
that this redefined or new dimension is made available to report users. This procedure is described in
the "Linking the Universe to Your Data Mart > Publishing the Universe Back to the Repository" section
of the Genesys Interactive Insights Deployment Guide.

Understanding Week Boundaries

The boundaries of 15-minute, hour, day, month, quarter, and year aggregation levels are very well
defined within any given Gregorian calendar year because each denomination represents an integral
fraction of that year; there are four whole quarters in a year, 12 full months, 365 (or 366) complete
days, and one year in a year. No single hour splits in such a way that part of the hour resides in one
year and the other part in the next, as is precisely the case for the beginning and/or ending weeks of
any given year.

Over and above this dual membership in each year, your system locale settings specify your
preferred date-related conventions, which include the definition of a week and on which day the week
begins. Different cultures observe different date conventions. As such, these variations in what
constitutes a week merit special discussion.

Week Boundaries, as Defined in Genesys Info Mart
The beginning of whole weeks in the Info Mart database is determined by the settings of the [date-
time]/first-day-of-week Genesys Info Mart configuration option in the [date-time] section. By
default, each week begins on Sunday and ends on Saturday. If report users specify any other week
range in the User Prompt Input area of the week reports that you create in Web Intelligence, such
as Monday to Sunday (when the default settings are used), the generated results display data for two
partial weeks instead of one seven-day period.

[+] More Information
In the Monday–Sunday example, this breaks down to:

• Six days, Monday–Saturday, for the first partial week and
• One day, Sunday–Sunday, for the second partial week.

In addition, the first and last weeks of the year could be partial weeks, depending on how the
simple-week-numbering Genesys Info Mart option is configured. A true value for this option
mandates that Week 1 begin with January 1 and that the last week end with December 31. Simple
week numbering is not the default.

There are other configuration options in the [date-time] section that affect the content of a week,
including the following:

• min-days-in-first-week
• date-time-min-days-ahead
• date-time-max-days-ahead
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Refer to the Reporting and Analytics Aggregates Deployment Guide for more information about these
and other week-related options. (The Genesys Info Mart 8.x release also supports
ISO-8601–compliant weeks which this section does not address.) Refer also to the discussion of the
DATE_TIME table in the relevant Genesys Info Mart reference manual for more information about the
definition of a week that is used by Genesys Info Mart.
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Using 15-Minute Aggregation
All of the included GI2 reports (except for the reports in the Details folder) enable drill-down of
results to a 30-minute level, by default, to enable you to review performance of your contact center
for each half-hour of a day. The sub-hour-interval Genesys Info Mart configuration option (in the
[agg] section) allows you to change this value. The Genesys Info Mart Server accepts a value of
15min for this option, which enables 15-minute aggregations, and therefore reporting at a 15-minute
level. To enable 15-minute reporting in the GI2 reports, change sub-hour-interval to 15, rerun the
aggregation job, and customize the universe and reports to use the 15 minutes dimension.

Note that the Reporting and Analytics Aggregates Deployment Guide recommends that you set the
aggregation level during the initial installation of Genesys Info Mart, and not change it thereafter.

Note that either 15 or 30 minutes is allowed—but not both simultaneously. Therefore, drill-up
operations from the 15-minute level in the GI2 reports that you customize take you directly to hour-
level results, and not to 30-minute results.

To Enable 15-minute Aggregation

Except where indicated, the following activities can be performed only on Microsoft Windows
platforms:

[+] Show Steps

1. In the Genesys Configuration Manager, open the Genesys Info Mart Application object that controls Info
Mart population.

2. Stop the aggregation process:
a. In the Genesys Info Mart Application object, in the [schedule] section, change the run-

aggregates configuration option to false.
b. If Job_AggregateGIM is running, stop it using the Genesys Info Mart Manager.
c. Wait until the current aggregation cycle completes. The following message appears in the Genesys

Info Mart log when it is done:
Stopped processing pending aggregation

3. As an optional but recommended step, disable the scheduler by setting the run-scheduler (in the
[schedule] section) configuration option to false, and use the Genesys Info Mart Manager to ensure
that no jobs are running.

Important
The following steps are database-intensive, so it is best to reduce the load and execute them when contact
center activity is at a minimum.

4. In the [agg] section, set the sub-hour-interval option to 15min and save your changes.
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Tip
Set the value of this option before the Genesys Info Mart Server runs for the first time and avoid changing it
thereafter.

5. Reaggregate data following the instructions provided in the Reporting and Analytics Aggregates User’s
Guide (see Reaggregating Data over a Certain Time Range). You can perform this step on any
supported platform. This step submits a request to delete and replace previously aggregated rows for
the specified time period. When the next aggregation cycle starts and completes, the AG2_*_SUBHR
tables contains data that is aggregated in 15-minute chunks.

6. If you disabled the scheduler in Step 3, re-enable it by setting run-scheduler to true.
7. Restart aggregation:

a. Reset run-aggregates to true.
b. Open the Genesys Info Mart Manager, and start Job_AggregateGIM.

Perform this operation during the time of day when the reaggregation process does not interfere
with ETL processing of new data or with end-user querying of existing Genesys Info Mart data.

8. Close the Genesys Configuration Manager, and open the the Information Design Tool application.
9. Under the Time class, rename the 30 minutes dimension appropriately—for example, to 15 minutes.

Genesys recommends that you rename the existing dimension instead of creating a new one.
10. In the dimension’s properties, set the SELECT statement to either of the following and apply your

changes:
• DATE_TIME.LABEL_YYYY_MM_DD_HH24_15INT

OR

• LABEL_YYYY_MM_DD_HH_15INT

If you choose the latter, you will not be able to distinguish between 12 AM and 12 PM in your week reports.

11. Save the universe, and export the universe back to the repository.

Your GI2 reports now display subhour results at the 15-minute level when you drill down from
hour results.
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Removing Fields from Reports
As you customize the GI2 reports to meet your business’s needs, there are some specific rules that
you should observe with regard to removing undesired dimensions and/or measures from the reports.
If you do not follow these recommendations, then under some circumstances, you might encounter
database and/or other errors when you run reports.

Remove Objects from the Presentation Layer

If you remove a measure or dimension from the report’s query, you must also remove it from the
presentation layer. (The converse is not necessarily true, however. If you remove a measure from the
presentation layer, you need not remove it from the report’s query—though doing so can improve
report performance.)

Remove Combination Objects

If the measure or dimension that you plan to remove from a report is the last one that belongs to a
particular class, then in addition to removing that dimension or measure, you must also remove any
corresponding Combination condition that pertains only to that dimension or measure.

The Combination conditions (such as Group Combination Sess and Group Combination) are
distinguished from the non-Combination conditions in that they provide filtering only against a
named series of aggregate tables. For example, whereas the Queue Group condition (a
non-Combination condition) can be used to filter mediation DN groups from any Info Mart table that
stores queue-related data, the Group Combination ABN condition can be used only to filter queue
group–related data from the AG2_QUEUE_ABN_* series of Info Mart tables.

If the Combination condition remains among a report’s query filters when no measures remain to
gather data from the aggregate table, the query returns a database error when it is executed against
the Info Mart database. You are likely to encounter this situation when you are removing measures
from reports that query more than one series of aggregate tables.
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Using Attached Data
This section provides information to help you customize the GI2 universe and reports to provide
results that are dimensioned by your own business’s user data.

Configuring Social Media User Data

The Social Engagement Report relies on how user data is configured in your environment, and on the
strategies you use to route interactions. This section describes how to set up your environment to
report on social media user data. The Social Engagement Report and the universe objects that
directly support it are described in the Genesys Interactive Insights Universe Guide. Perform the
following steps to configure social media user data:

[+] Show Steps

1. Review the routing strategies in your environment with respect to user data and update them as
appropriate. Note that the default Genesys-provided routing strategies do not set the Sent reason
when responses are sent. You must design your strategy to change the StopProcessing reason from
Normal to Sent when this event occurs. If you do not do so, the GI2 third-party media reports generate
results for transfers only—not for responses.

2. In the ccon_adata_spec_GIM_example.xml file that is provided within the Genesys Info Mart installation
package, uncomment the appropriate rows to enable Interaction Concentrator (ICON) to record data for
the following user data keys:
• Classify_Actionability_CtgRelevancy
• Classify_Sentiment_CtgRelevancy
• KloutScore
• CtgName
• Screen_Sentiment_CtgName
• Screen_Actionability_CtgName
• Classify_Actionability_CtgName
• Classify_Sentiment_CtgName
• desktop_influence

Place this file in ICON’s root directory. Refer to Steps 1 and 2 of Enabling Reporting on User Data in the
Genesys Info Mart Deployment Guide for detailed instructions.

3. Run make_gim_UDE_template_<rdbms>.sql against the Info Mart database to create the database
objects for social media detail reporting. This SQL script is deployed in the \script subfolder as part of
a GI2 installation. Refer to the Application Files chapter of the Reporting and Analytics Aggregates
Deployment Guide for more information.

4. Run aggregation in autonomous mode and specify the setFeature runtime parameter as follows:
-setFeature=eServicesSM
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This parameter enables RAA to aggregate social media data, including mapping GEN_ES_KEY (in the
IRF_USER_DATA_KEYS table) to USER_DATA_KEY1 in the H_ID, H_AGENT, and H_AGENT_QUEUE
hierarchies. Note that USER_DATA_KEY1 can be mapped only once per hierarchy. If you previously
mapped this field to CUSTOM_KEY_10 (as instructed in step 2 of Example - Product Line and Product)
for the Product Line example, then consider mapping USER_DATA_KEY2 to CUSTOM_KEY_10 instead.
Refer to the Reporting and Analytics Aggregates User’s Guide to learn how to run aggregation in this
autonomous mode.

Your environment is ready to process social media user data for each interaction, and RAA is
equipped to aggregate this data. You can now use the Agent Social Engagement and Social
Engagement reports to retrieve meaningful data.

The following section describes additional hidden universe objects, some of which indirectly support
social media user data reporting.

Hidden User Data Objects in GI2_Universe

Universe objects that report on user data, and which are visible to report designers and viewers, are
described in the Genesys Interactive Insights Universe Guide. Some objects, however, are hidden in
the universe.

The table following table lists those hidden objects that are related to user data. You must properly
set up your environment and unhide these objects before you can use them to create reports.

[+] Predefined, Hidden User Data Objects

Class and Member User Data Table and
Field Char or Numeric

Agent\Activity

M Actionability

AG2_AGENT_*.ACTIONABILITY
AG2_AGENT_GRP_*.ACTIONABILITY

AG2_AGENT_QUEUE_*.ACTIONABILITY
Numeric

M Influence Score

AG2_AGENT_*.INFLUENCE
AG2_AGENT_GRP_*.INFLUENCE

AG2_AGENT_QUEUE_*.INFLUENCE
Numeric

M Offered with
Actionability

AG2_AGENT_*.ACTIONABILITY_OFFERED
AG2_AGENT_GRP_*.

ACTIONABILITY_OFFERED

AG2_AGENT_QUEUE_*.

ACTIONABILITY_OFFERED

Numeric

M Offered with Influence AG2_AGENT_*.INFLUENCE_OFFEREDNumeric
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Class and Member User Data Table and
Field Char or Numeric

AG2_AGENT_GRP_*.INFLUENCE_OFFERED

AG2_AGENT_QUEUE_*.INFLUENCE_OFFERED

M Offered with Sentiment

AG2_AGENT_*.SENTIMENT_OFFERED
AG2_AGENT_GRP_*.SENTIMENT_OFFERED

AG2_AGENT_QUEUE_*.SENTIMENT_OFFERED
Numeric

M SentimentScore

AG2_AGENT_*.SENTIMENT
AG2_AGENT_GRP_*.SENTIMENT

AG2_AGENT_QUEUE_*.SENTIMENT
Numeric

Agent\Activity\Activity User Data Example

D

Dimension 1
Dimension 2

...

Dimension 5

USER_DATA_CUST_DIM_1.DIM_ATTRIBUTE_1
USER_DATA_CUST_DIM_1.DIM_ATTRIBUTE_2

USER_DATA_CUST_DIM_1.DIM_ATTRIBUTE_5

Char

D

Dimension 6
...

Dimension 10

USER_DATA_CUST_DIM_2.DIM_ATTRIBUTE_1

USER_DATA_CUST_DIM_2.DIM_ATTRIBUTE_5
Char

D Screen Actionability
Category

USER_DATA_GEN_ES.SCREEN_
ACTIONABILITY_CTGNAMEChar

D Screen Sentiment
Category

USER_DATA_GEN_ES.SCREEN_
SENTIMENT_CTGNAME Char

Business Attribute\BA Customer
M Actionability Score AG2_ID_*.ACTIONABILITY Numeric

M Entered with
Actionability AG2_ID_*.ACTIONABILITY_ENTEREDNumeric

M Entered with Influence AG2_ID_*.INFLUENCE_ENTEREDNumeric
M Entered with Sentiment AG2_ID_*.SENTIMENT_ENTEREDNumeric
M Influence Score AG2_ID_*.INFLUENCE Numeric

M Sentiment Factor
a factor of BA User Data
Example\Classify
Sentiment Category

Numeric

M Sentiment Score AG2_ID_*.SENTIMENT Numeric
Business Attribute\BA User Data Example

D Dimension 1 USER_DATA_CUST_DIM_1.DIM_ATTRIBUTE_1Char
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Class and Member User Data Table and
Field Char or Numeric

Dimension 2

...

Dimension 5

Dimension 6

...

Dimension 10

USER_DATA_CUST_DIM_1.DIM_ATTRIBUTE_2

USER_DATA_CUST_DIM_1.DIM_ATTRIBUTE_5

USER_DATA_CUST_DIM_2.DIM_ATTRIBUTE_1

USER_DATA_CUST_DIM_2.DIM_ATTRIBUTE_5

D Screen Actionability
Category

USER_DATA_GEN_ES.SCREEN_
ACTIONABILITY_CTGNAME Char

D Screen Sentiment
Category

USER_DATA_GEN_ES.SCREEN_
SENTIMENT_CTGNAME

Char

Flow\Flow User Data Example

M

Detail 1
Detail 2

...

Detail 14

Detail 15

Detail 16

IRF_USER_DATA_CUST_1.CUSTOM_DATA_1
IRF_USER_DATA_CUST_1.CUSTOM_DATA_2

...

IRF_USER_DATA_CUST_1.CUSTOM_DATA_14

IRF_USER_DATA_CUST_1.CUSTOM_DATA_15

IRF_USER_DATA_CUST_1.CUSTOM_DATA_16

Char
Char

Char

Numeric

Numeric

Handling Attempt\Handling User Data Example

M

Detail 1
Detail 2

...

Detail 14

Detail 15

Detail 16

IRF_USER_DATA_CUST_1.CUSTOM_DATA_1
IRF_USER_DATA_CUST_1.CUSTOM_DATA_2

IRF_USER_DATA_CUST_1.CUSTOM_DATA_14

IRF_USER_DATA_CUST_1.CUSTOM_DATA_15

IRF_USER_DATA_CUST_1.CUSTOM_DATA_16

Char
Char

Char

Numeric

Numeric

Queue User Data Example

D

Dimension 1
Dimension 2

...

Dimension 5

USER_DATA_CUST_DIM_1.DIM_ATTRIBUTE_1
USER_DATA_CUST_DIM_1.DIM_ATTRIBUTE_2

USER_DATA_CUST_DIM_1.DIM_ATTRIBUTE_5

Char

D
Dimension 6
...

USER_DATA_CUST_DIM_2.DIM_ATTRIBUTE_1

USER_DATA_CUST_DIM_2.DIM_ATTRIBUTE_5
Char
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Class and Member User Data Table and
Field Char or Numeric

Dimension 10

Using the Predefined User Data Objects

If the user data that you configured within your environment exactly matches the sample tables that
have been imported into GI2_universe—as well as their structure—all you have to do to use the
predefined user data objects in custom reports is make visible the corresponding universe elements
and save and export the universe to the BI repository. The objects will be revealed to report designers
and can be used in reports just like any other universe object. If, however, your user data
configuration employs different tables or table structure, perform the following steps within Web
Intelligence to avail their use to report designers:

[+] Show Steps

1. If necessary, add the appropriate user data table(s) to GI2 universe schema. (See step 4 of Example -
Product Line and Product.)

2. To use the predefined user data objects, show only those objects that you intend to use. User data
classes, dimensions, and measures are marked as hidden within the universe so that they are not
available to report designers before their time.

3. Alter user data object definitions, as needed:
• For instance, fields in the IRF_USER_DATA_CUST_* tables could be numeric or character.
• Perhaps your user data table is named differently from that which is used in the table above.
• Perhaps you want the dimension or detail to reference a field different from that which is already

defined for the object.
• Perhaps you want to reference a list of values and have the dimension available as a user prompt on

a custom report. (See step 5 of Example - Product Line and Product)
• Perhaps you want to rename the predefined classes, dimensions, or measures.

4. Save the universe and export it to the BI repository.

Special Note about Numeric User Data

The Customer Perspective Report includes four measures that are based on numeric user
data—Revenue, Satisfaction, Avg Revenue, and Avg Satisfaction. Running aggregation (to
populate the data for this report) will yield errors if users are permitted to attach non-numeric data
for these business attributes to interactions. You must ensure that the resources that set the values
of Revenue and Satisfaction user data keys are configured or trained, as applicable, to record
numerical values only. Refer to Check for Incorrect Data Type in the Reporting and Analytics
Aggregates User’s Guide to learn how to recover from this situation.

In addition to the information on this page, see:
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• Example - Product Line and Product
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Example - Product Line and Product
This customization example adds two dimensions to the Info Mart database that are derived from
string-based attached data that might exist in your environment. These dimensions (Product Line and
Product) form a Product hierarchy within the GI2 universe that you can drill. You can add these
dimensions to the GI2 reports to provide results by product, by product line, or by any other
dimension that you choose to substitute in this example.

The general steps for customization are the following:

1. Create and populate one or more user data
tables in the Info Mart database.

[+] Show Steps

Creating User Data Dimension
Tables
Within the Info Mart database, create and populate a custom
user data dimension table—for example,
USER_DATA_CUST_DIM_10. The USER_DATA_CUST_DIM_x tables
store information about changes in data that accompany
telephony events that are recorded by Interaction Concentrator
(ICON) and further processed by Genesys Info Mart ETL runtime
processes. Genesys Info Mart writes to these tables up to five
descriptors of your business data. This example populates two
fields: PRODUCT_LINE with product line data and
PRODUCT_CODE with product code data.

Refer to the relevant Genesys Info Mart Reference Manual
(available on docs.genesys.com) for the complete data model of
the USER_DATA_CUST_DIM_* tables.

2. Configure user data keys in the aggregation
tables to point to your user data table(s) and
populate the aggregation tables.

[+] Show Steps

Mapping User Data Keys and
Columns
The information in this section describes how to configure user
data keys and columns in the Info Mart database Mapping and
Aggregation tables.

User Data Mapping Tables in the Info
Mart
Deployment-specific attributes, in the form of user-defined
attached data, are represented in the Genesys Info Mart model
both by low-cardinality data (in string format) and high-
cardinality data (in numeric, date/time, and string formats).
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Low-cardinality-string user data that is associated with an
interaction resource—such as automobile models and product
codes—is stored in the IRF_USER_DATA_KEYS and
USER_DATA_CUST_DIM_x dimension tables. High-cardinality user
data that is associated with an interaction resource—such as
prices, number of widgets sold, and dates—is stored in the
IRF_USER_DATA_GEN_1 and IRF_USER_DATA_CUST_x fact
extension tables. In addition to these tables are the
CTL_UD_TO_UDE_MAPPING and
CTL_UDE_KEYS_TO_DIM_MAPPING tables that you must update:

• CTL_UD_TO_UDE_MAPPING ties in user data
keys that are defined in the underlying ICON
application with user data columns that are
defined in the previous tables.

• CTL_UDE_KEYS_TO_DIM_MAPPING maps the
user data dimension tables
(USER_DATA_CUST_DIM_x) to
IRF_USER_DATA_KEYS.

Execute the sample script (Sample SQL Script for Creating and
Mapping User Data) to set up user data mapping and recording
in your environment. Also, refer to the:

• Interaction Concentrator Deployment Guide.
• make_gim_UDE_template.sql script, provided

with Genesys Info Mart deployment. Note that
RAA deploys similar
scripts—make_gim_UDE_template_<rdbms>.sq
l. These scripts, however, hold entirely
different content and are designed to configure
user data for social media measures.

• Mapping User Data Worksheet in the Genesys
Info Mart Deployment Guide. This worksheet
contains several columns that you can use to
record information about the specific attached
data key in use in your environment. Consider
adding each custom attached data table in use
within your environment to this worksheet.
• Refer to Special Note about Numeric User

Data for information about configuring keys
for Revenue and Satisfaction user data.

• The instructions in step 4 (below) for adding
user data dimensions to the universe and
customizing the GI2 reports apply to all of
the fields in this worksheet.

Predefined attached data also appears in other Info Mart
database tables, including the following:

• INTERACTION_DESCRIPTOR (fields
CUSTOMER_SEGMENT, SERVICE_TYPE,
SERVICE_SUBTYPE, BUSINESS_RESULT)

• STRATEGY
• REQUESTED_SKILL
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• ROUTING_TARGET
Using the attached data from these tables falls outside the
scope of this section. Several GI2 reports, however, are provided
for all of the attached data-related fields in the
INTERACTION_DESCRIPTOR table.

Configuring User Data Keys in the
Aggregation Tables
The AG2_AGENT, AG2_AGENT_CAMPAIGN, AG2_AGENT_QUEUE,
AG2_CAMPAIGN, and AG2_ID aggregate tables provide two key
columns each that you can configure to join to two user data
dimension tables of your choice. (Recall that the user data
dimension tables store low cardinality, string data only.) The
AG2_AGENT_GRP aggregate tables also provide two such
columns, but their values are inherited from the AG2_AGENT
tables. The USER_DATA_KEY fields are not available in the agent
session, agent states, agent interval, and queue-only aggregate
tables.

Mapping User Data Keys in the Aggregate Tables/Views to User Data
Dimensions

These columns are:

• USER_DATA_KEY1—A key that points to one
dimension table, such as
USER_DATA_CUST_DIM_10, storing five
dimensions

• USER_DATA_KEY2—A key that points to a second
dimension table, storing another five
dimensions

These two fields provide access to a total of 10 attached data
dimensions—or two hierarchies—for each aggregate table and
view, as shown in the figure to the right. You must configure the
aggregation job to aggregate and populate these fields.

Our product-line example uses the business attribute aggregate
set, AG2_ID_*, which consists of four tables and three views. We
must configure the USER_DATA_KEY1 column in each to point to
the custom user data dimension table,
USER_DATA_CUST_DIM_10. For more information about how to
map the USER_DATA_KEY2 field, see How Do I Configure User
Data for Aggregation? in the Reporting and Analytics
Aggregates User’s Guide.

1. Create a text file having the following content
on a single line:
(map-user-data-key (hierarchy: H_ID)
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(dimension: USER_DATA_KEY1) (expression:
irfud.CUSTOM_KEY_10))

2. Save the file in the Genesys Info Mart root
directory with the name user-data-map.ss.
The next time Genesys Info Mart Server
restarts, the aggregation process detects this
file, and aggregation begins.

Refer to the Reporting and Analytics Aggregates Reference
Manual for a data model of the aggregation tables in the Info
Mart database, and the relevant Genesys Info Mart Reference
Manual (available on docs.genesys.com for the structure of the
USER_DATA_CUST_DIM_* tables.

3. Set Genesys Info Mart and Interaction
Concentrator configuration options for collection of
user data.

[+] Show Steps

Setting Configuration Options
Several options are available that you can use to configure what
data is written to the Info Mart database, and how long data is
retained. In particular, you can configure storage of user data as
follows:

• On Interaction Concentrator, by means of the
attached data specification file
(adata_spec.xml) and ICON configuration
options, such as EventData, for event-based
user data.

• On Genesys Info Mart, by means of
customizable SQL scripts to create mapping
and storage tables in the Info Mart database.

Some of these options apply specifically to user data. Interim
releases of Genesys Info Mart and Interaction Concentrator
might also introduce new configuration options that affect
results. Review the following documents for a listing and
description of these options:

• Genesys Info Mart Deployment Guide

• Genesys Info Mart Release Notes

• Interaction Concentrator Deployment Guide

• Interaction Concentrator Release Notes

4. Add the attached data tables to the universe
structure. [+] Show Steps
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Adding Attached Data Tables
to the Universe
After you have created and populated a user data table, you
must add it to the universe and define joins between the user
data table and those aggregate tables from which you plan to
dimension data in the Interactive Insights reports. Note that you
can use your RDBMS to define joins between tables or you can
define these joins within the Information Design Tool. This
section illustrates defining joins within the Information Design
Tool.

The GI2_universe schema includes custom user data tables:
USER_DATA_CUST_DIM_1, USER_DATA_CUST_DIM_2,
IRF_USER_DATA_CUST_1, and IRF_USER_DATA_CUST_2 with the
appropriate joins and contexts already defined. If, however, you
choose to include user data tables that are named or structured
differently, you must add the tables to the universe schema
yourself.

Inserting a table

Our product-line example relies on data that is stored in the
USER_DATA_CUST_DIM_10 table, so we must perform the
following steps:

1. Open the GI2_Universe Data Foundation in the
Information Design Tool.

2. From the menu bar, select Insert Object >
Insert Tables to open the Insert Tables
Browser and locate your attached data table.

3. Select your table—USER_DATA_CUST_DIM_10,
using this example—and click Finish. A symbol
for the table appears in the Structure panel.
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The Edit Join Dialog Box

4. From the Insert menu, select Insert Join to
display the Edit Join dialog box, shown in the
figure The Edit Join Dialog Box. Here, we will
add joins between the attached data table and
each variation of an aggregate table:
a. From the Table 1 drop-down list, select the

USER_DATA_CUST_DIM_10 table, and
select ID from the list.

b. From the comparison drop-down list, select
the equal sign (=).

c. From the Table 2 drop-down list, select the
AG2_ID_HOUR table, and select
USER_DATA_KEY1 from the list.

d. Set the cardinality for one (1) to many (N).
e. Click OK.

5. Reopen the Edit Join dialog box and repeat
steps a through e to establish joins between the
attached data table and each of the remaining
AG2_ID_* tables and views:
• AG2_ID_DAY
• AG2_ID_MONTH
• AG2_ID_SUBHR
• AG2_ID_WEEK
• AG2_ID_QRTR
• AG2_ID_YEAR

Next, we add these new joins to the contexts that already exist
in the universe so that any join paths will automatically be
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resolved when report queries are run against the Info Mart
database.

5. Add LOV, dimensions, and filters.

[+] Show Steps

Adding Dimensions and Filters
to the Universe
With the user data tables added to the universe, joins
established between them, and the aggregate tables and
contexts defined, we can now add two new dimensions and
filters to the universe. These objects are used in the report that
we will create.

Adding LOV
Before we create the dimensions, we must add LOV that will be
associated with the dimensions. Complete the following steps to
add and define Product and Product Line LOV.

Insert Combined Query

1. In the Information Design Tool, in the Business
Layer list, click Parameters and Lists of
Values.

2. On the menu bar for List of Values, click Insert
Object -> List of Values based on business
layer objects.
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The properties for the new LOV appears.
3. In the Name field, enter lov_product_line.
4. Click Edit Query.

The Query Panel appears.
5. In the Query Panel, select the Business

Attribute\Product Line dimension.
6. If the Combined Queries panel is not visible,

click Show/Hide Combined Queries Panel,
then click Insert Combined Query, and create
a combined query, selecting the dimensions
Service Objects and All.

7. Save the universe.
8. Repeat steps 1 through 7 for the Product code

(in the Name field, enter lov_product).
9. Publish the universe to a repository.

Creating Dimensions Based on User
Data
Complete the following steps to add and define the Product
and Product Line dimensions to the Business Attribute
class.

1. Within the Information Design Tool, in the
Business Layer list, click the Business
Attribute class.

2. On the menu bar, click Insert > Dimension.
The properties for the new dimension appear.

3. In the name field, enter the name Product
Line, and set other properties of this object as
follows:
a. Set the data type to String and the Select

statement to
USER_DATA_CUST_DIM_10.PRODUCT_LINE.

b. On the Advanced tab, select the Associate
a List of Values checkbox, and select an
appropriate name for the product line list of
values, such as lov_product_line.

4. Repeat steps 1 through 3 to create the Product
Code dimension, setting the Select statement
to USER_DATA_CUST_DIM_10.PRODUCT_CODE and
the list of values to lov_product.

5. Save the universe and export it to the
repository.

The sample report that we create offers report users the
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opportunity to select one or more products or product lines in
which to generate results. One way to utilize this capability is to
prepare two filter universe objects that populate two product-
oriented user prompts in our report. To do so, first create
necessary parameters, and then create fileters based on them:

Creating Parameters
Complete the following steps to add and define the Parameters
required for filtering.

1. In the Information Design Tool, click the
Parameters and Lists of Values class.

2. On the menu bar for Parameters, click Insert
Parameter.
The properties for the new Parameter appear.

3. In the Name field, enter Product Line.
4. In the Prompt Text field, enter Product Line:.
5. Next to Associate a List Of Values, click the

... button.
The Select a List of Values dialog box
appears.

6. Select List of Values defined in the
business layer, and select product_line_lov
from the list.

7. Click the Set default Value radio button, and
from the list, select ALL.

8. Save the universe.
9. Publish the universe to a repository.

Creating Filters
Complete the following steps to add and define Filters based on
the LOV we previously created.

1. In the Information Design Tool, in the Business
Layer list, click the Business Attribute class.

2. On the menu bar, click Insert Object > Filter.
The properties for the new filter appear.

3. Rename the Filter as Product Line, and set its
Where clause to the following:
@Select(Business Attribute\Product Line)
IN @Prompt(Product Line:) OR ' ALL' in
@Prompt(Product Line:)

4. On the menu bar, click Insert Object > Filter.
The properties for the new filter appear.

5. Rename the Filter as Product Code, and set its
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Where clause to the following:
@Select(Business Attribute\Product Code)
IN @Prompt(Product Code:) OR ' ALL' in
@Prompt(Product Code:)

Refer to BO/BI documentation for more information about
how to define filters.

6. Define a hierarchy within the universe for
attached data that has parent-child relationships,
such as Product Line and Product.

[+] Show Steps

Defining a Hierarchy to the
Universe
This example created two dimensions that share a parent-child
relationship: a product belongs to a specific product line, and a
product line consists of one or more products. The custom
dimensions that you create might not share this section. We
continue this example by defining a Product hierarchy, which
makes drill up and drill down functionality available along
product lines in the reports that you customize.

Defining the Product Hierarchy

1. Open the Business Layer by clicking the
business layer name in the Local Projects
view.

2. In the Business Layer list, click the Navigation
Path class.
The Navigation Path properties appear, as
shown in the figure Defining the Product
Hierarchy.

3. In the Name field, type a suitable name for the
hierarchy—for example, Business Attribute
- Product. Keep this hierarchy highlighted.

4. Click Add, and in the Available Dimensions
list, in the Business Attribute class, select the
Product Line and Product Code dimensions.

5. Click OK to save this new hierarchy and close
the editor.

6. Save the universe and publish it to the
repository.

7. Save the universe and export it to the repository.
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8. Customize the Interactive Insights reports to
include your attached data dimensions.

[+] Show Steps

Creating a Product-Line
Business Attribute Report
Using the dimensions that you added to the universe in step 5,
you can now build one or more business attribute reports that
provide the results of your contact center activity by product
line and product. The easiest way to create one such report is to
make a copy of the Interaction Volume Service Type Report, and
tailor it to use the Product Line and Product dimensions
(instead of Service Type and Service Subtype dimensions)
using the following steps:

1. Within BI LaunchPad, copy Interaction Volume
Service Type Report to a working folder.

2. Open the report properties, and rename the
report appropriately—for example, Interaction
Volume Product Line Report. Change its
description, as desired, and save your changes.

3. Edit the text on the Description tab, as
appropriate, and click Save and Close.

4. Right-click a report, and in the context menu,
select Modify to open the report for editing.
Complete the following steps:
a. On the Data Access tab, Data Providers

sub-tab, click Edit Data.
b. In the Query Panel, browse in the

hierarchical list on the left, and double-click
the Product Line dimension to copy it into
the Result Objects window. (Do not yet
remove the Service Type dimension from
the Result Objects window.)

c. Close the Query Panel.
d. Edit the report structure on both the

Summary and Main tabs to replace the
'Service Type' dimension, labels, and text
with 'Product Line', wherever it occurs. Do
the same for 'Service Subtype', replacing it
with 'Product Code'.

e. Replace the Service Type section with a
Product Line section:
i. Right click the report and choose Show

Structure.
ii. Select the Service Type section and

change the formula from =[Service
Type] to =[Product Line].
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f. Click Edit Data Provider, and in the Query
Panel, in the Query Filters field, replace
the Service Type and Service Subtype
dimensions with Product Line and
Product Code, respectively. Close the
Query Panel.

g. Save and test your changes.

5. When you are satisfied with the report results,
click Edit Data Provider, and in the Query
Panel, edit the report query to remove the
Service Type dimension from the Result
Objects window, save, and retest the report.

Sample SQL Script for Creating and Mapping User Data

The following sample script provides the SQL code that is used for this example.

[+] Show Sample Code
Note that this is a sample script only. You should validate it for use within your environment.

IF EXISTS ( SELECT 1
FROM sysobjects
WHERE id = object_id('USER_DATA_CUST_DIM_10') AND type = 'U' )
DROP TABLE USER_DATA_CUST_DIM_10

GO

CREATE TABLE USER_DATA_CUST_DIM_10 (
ID               INT identity     ,
TENANT_KEY       INT NOT NULL     ,
CREATE_AUDIT_KEY INT NOT NULL     ,
PRODUCT_LINE     VARCHAR(170) NOT NULL DEFAULT 'none',
PRODUCT_CODE     VARCHAR(170) NOT NULL DEFAULT 'none',
DIM_ATTRIBUTE_3  VARCHAR(170) NOT NULL DEFAULT 'none',
DIM_ATTRIBUTE_4  VARCHAR(170) NOT NULL DEFAULT 'none',
DIM_ATTRIBUTE_5  VARCHAR(170) NOT NULL DEFAULT 'none',
CONSTRAINT PK_USER_DATA_CUST_DIM_10 PRIMARY KEY(ID) )

GO

SET IDENTITY_INSERT USER_DATA_CUST_DIM_10 ON;

-- This row is for the predefined key 'UNKNOWN'. It is
-- mandatory. Do not remove it!
INSERT INTO USER_DATA_CUST_DIM_10 (

ID,
TENANT_KEY,
CREATE_AUDIT_KEY )

VALUES ( -1, -1, -1 ) ;
GO

-- This row is for the predefined key 'NO_VALUE'. It is
-- mandatory. Do not remove it!
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INSERT INTO USER_DATA_CUST_DIM_10 (
ID,
TENANT_KEY,
CREATE_AUDIT_KEY )

VALUES ( -2, -2, -1 ) ;
GO

SET IDENTITY_INSERT USER_DATA_CUST_DIM_10 OFF;

-- Add a foreign key reference column from IRF_USER_DATA_KEYS
-- to the user data dimension table.
--
-- Note: Adding columns to a sizeable IRF_USER_DATA_KEYS table
-- could consume significant DBMS resources and time. Consider the
-- tradeoff between:
-- (1) adding redundant columns initially and adding/activating
--     mapping later and
-- (2) adding columns later.

ALTER TABLE IRF_USER_DATA_KEYS
ADD CUSTOM_KEY_10 INT NOT NULL DEFAULT -2

GO

-- Add mapping between user data dimension table and
-- IRF_USER_DATA_KEYS to CTL_UDE_KEYS_TO_DIM_MAPPING

INSERT INTO CTL_UDE_KEYS_TO_DIM_MAPPING (
DIM_TABLE_NAME,
DIM_TABLE_PK_NAME,
UDE_KEY_NAME )

VALUES (
'USER_DATA_CUST_DIM_10',
'ID',
'CUSTOM_KEY_10' )

GO

-- Add mapping between user data keys and user data tables to
-- CTL_UD_TO_UDE_MAPPING.
--
-- Note: ICON should be configured to record these user data keys.

INSERT INTO CTL_UD_TO_UDE_MAPPING (
ID              ,
UD_KEY_NAME     ,
UDE_TABLE_NAME  ,
UDE_COLUMN_NAME ,
PROPAGATION_RULE,
DEFAULT_VALUE   ,
ACTIVE_FLAG )

VALUES (
103                    ,
'CustomProductLine'    ,
'USER_DATA_CUST_DIM_10',
'PRODUCT_LINE'         ,
'CALL'                 ,
''                     ,
1 )

GO

INSERT INTO CTL_UD_TO_UDE_MAPPING (
ID              ,
UD_KEY_NAME     ,
UDE_TABLE_NAME  ,
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UDE_COLUMN_NAME ,
PROPAGATION_RULE,
DEFAULT_VALUE   ,
ACTIVE_FLAG  )

VALUES (
104                    ,
'CustomProductCode'    ,
'USER_DATA_CUST_DIM_10',
'PRODUCT_CODE'         ,
'CALL'                 ,
''                     ,
1  )

GO
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Changing the Forecast

Time Ranges for the Interaction Volume Service Type
Trend Report

The Interaction Volume Service Type Trend Report (sometimes called the Trend report) provides a
forecast of one service-level measure based on the historical values that are retrieved within the time
range that is bound by the start and end dates that you specify. The report provides forecasted data
beginning from the end date and extending through the forecast-thru date that you specify, as shown
in the figure Time Ranges for the Interaction Volume Service Type Trend Report. The Interaction
Volume Service Type Trend Report uses several variable-based measures (discussed on this page,
under Swapping the Forecast Measure) to load the terms for a least-squared forecast calculation.
These variables are reserved for internal use; alter them only as instructed below.

Swapping the Forecast Measure

The Measure variable identifies the universe measure that is used to compute the trend. Resetting
this variable to another measure will not break the formula. As packaged, the % First Response
Service Level measure in the BA Customer class is assigned to this variable. You can customize a
copy of the report to provide a forecast of a different measure. To do so, perform the following steps:

[+] Show Steps

1. Choose the measure that you want to substitute—for example, Entered, in the Business Attributes
class.

2. Within BI LaunchPad, make a copy of the Interaction Volume Service Type Trend Report and retitle it
accordingly—for example, Interaction Volume Entered Trend Report:
a. Select the report to copy, and choose Organize > Copy.
b. Select the folder in which to paste the report, and choose Organize > Paste.
c. Right click the report and choose Properties. Edit the Title, and click Save & Close.

3. Right-click a report, and in the context menu, select Modify to open the report for editing.
4. On the Data Access tab, Data Providers sub-tab, click Edit Data.
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Edit Variable

5. On the Query Panel, add the measure you want to add to both combined queries (Combined Query 1
[for current data] and Combined Query 2 [for forecasted data]):
a. Select Combined Query 1, then double click the measure you want to add (this adds it to the

Result Objects field).
b. Select Combined Query 2, then double click the measure you want to add (this adds it to the

Result Objects field).
Do not yet remove the % First Response Service Level measure.
Close the Query Panel.

6. From the toolbar, click Design > With Data.
7. In the Available Objects list, double-click Measure to open the Edit Variable dialog box.

The figure Edit Variable shows the main Available Objects list, and the Edit Variable dialog
box. Note that the Edit Variable dialog box also contains a list called 'Available Objects'.

8. Create the new variable as follows:
a. In the Name field, type a name for the variable.
b. In the Formula field, replace [% First Response Time Service Level] with the measure that

you chose in Step 1 (for example, Entered) and click OK.
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Alerter

9. If your selected measure yields values that are greater than 1—as is the case with the example
Entered, given in Step 1—perform the following steps on the Main tab of the report:
a. Set Forecast Alerter (the alerter that is associated with the forecast column, shown in the figure

Alerter) appropriately, or remove it altogether.
b. Update the legend.
c. In the Available Objects list, double-click the Trend Line variable and change its formula to the

following:
If [A] * [Dimension With Forecast] + [B] < 0 Then 0
Else [A] * [Dimension With Forecast] + [B]

10. Appropriately rename any strings that indicate the name of the measure that is to be replaced. On the
report Summary tab, for instance, change the name of the axis, change the chart name, and, in the
report structure, change the hardcoded string % First Response Time Service Level over Time to
Entered over Time.

11. On the report Description tab, add the Entered measure and its description to the table. Change the
report description appropriately.

12. (Optional) On the Query Panel, remove any measures that you no longer want to appear in the query.
13. Save and test your report.

Tip
In the GI2 universe, the First Response in Threshold and Entered with Objective
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measures (the first two columns of the Trend report) are used to derive % First
Response Time Service Level (the third column in the report). If you swap the
service-level measure for another, as instructed in the preceding section, you might
also want to swap out the first two measures. Be sure to add any new measures to
both halves of the underlying combined query and set the columns of the main table
appropriately.

Managing the Report Dimensions

Among the internal variables of the Interaction Volume Service Type Trend Report are some that
parameterize dimensions. This section demonstrates how to modify such variables and the report
structure to reflect different dimensions.

Changing Dimensions Other than Time dimensions
The following abbreviated steps demonstrate how to define additional or fewer dimensions within the
report:

[+] Show Steps

1. On the Query Panel, add the desired dimension to (or remove it from) both combined queries.
2. In the Available Objects list, double-click Dimension With Forecast to open the variable editor.

Change this variable definition to include or remove the desired dimension. For instance, the following
definition adds the Service Type dimension:
=RunningCount([Time Dimension];([Tenant Name];[Media Type];[Service Type]))

3. Click Document Structure and Filters and modify the report section as desired.
4. Save and test your report.

Changing Time Dimensions
To change the report time dimension, perform the following abbreviated steps:

[+] Show Steps
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Hidden Columns in the Trend Report

1. In the Query Panel, add the desired time dimension to both combined queries. For example, add
Month. Do not yet remove the Day dimension.

2. In the Available Objects list, double-click Time Dimension to open the variable editor. Change this
variable definition to match the added dimension—for example, to =[Month].

3. Click Close > Apply changes and close.
Between the first two visible columns in the main table of the report are two hidden columns: [Day]
and [Is Current Data]. The figure Hidden Columns in the Trend Report shows the hidden [Day]
column, highlighted within the red rectangle.

4. Select the hidden [Day] column and change its formula to your desired dimension—for example, to
=[Month].

5. (Optional) On the Query Panel, remove any time dimensions that you no longer want to appear in the
query.

6. Save and test your report.
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Using Cascading Prompts
By default, the user prompts in the GI2 reports do not observe interrelationships between the objects
that users select for report generation even though direct relationships might exist within the contact
center. (The one exception to this rule is described in Prompt Interrelationships.) Users can, for
example, select any combination of agents against which to run a report regardless of the groups to
which the agents belong and regardless of the agent groups which the report user selects. The GI2
universe features agent and queue cascading prompts whose purpose is to limit user selections
during report generation to only those members that belong to the selected agent group(s) or queue
group(s). This functionality is delivered through either of the following methods:

• Modify the Universe LOVs—Customize the agent and queue lists of values in the universe.
• Modify the Report Query—Customize the reports to replace agent and queue user prompts with those

cascading objects described in the table, Universe Objects Used for Cascading Prompts. (Some of these
objects are hidden.)

This page demonstrates how to implement cascading-prompt functionality within your reports using
both methods and discusses the limitations associated with their use.

Table: Universe Objects Used for Cascading Prompts
[+] Show Table

Universe Object Description
Class Object

Service Objects

Agent Cascade dimension

Same as the Agent Name
dimension except this object
employs agentcascade_lov to
populate values instead of
agentname_lov.

Agent Cascade condition

Same as the Agent condition
except this object references the
Agent Cascade dimension
instead of the Agent Name
dimension.

Queue Cascade dimension
Same as the Queue dimension
except this object employs
queuecascade_lov to populate
values instead of queue_lov.

Queue Cascade condition
Same as the Queue condition
except this object references the
Queue Cascade dimension
instead of the Queue dimension.

Customizing the GI2 Universe and Reports Using Cascading Prompts

Genesys Interactive Insights User's Guide 81



Modify the Universe LOVs

The benefit in the approach of modifying the agent and queue lists of values (LOVs) in the universe to
provide cascade functionality is that all reports (that employ agent and queue LOVs) reflect this
change automatically. Any report that references the altered LOVs will reflect cascading-prompt
behavior. However, this approach also has a drawback in the scenario in which you want only a
subset of reports to use cascade functionality.

To add cascading prompts to a report using the modify-the-LOV approach, perform the following
steps:

[+] Show Steps

1. In the Information Design Tool, open the GI2 universe.
2. In the Business Layer list, click the Parameters and List of values class.
3. From the List of Values list, select agentname_lov.
4. Click Edit Query. The Query Panel opens, where you can modify the code for the agentname_lov list

of value.
5. Click View Script, and enable Use custom query script.
6. Replace the code in the [Query] script field with the following, and click OK:
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select CONST_VALUE from
(

select CONST_VALUE, 0 SEQ_NUM
from CONSTANTS2_GI2 where CONST_TYPE='CONSTANT' and CONST_VALUE=' ALL'
and ' ALL' IN @Prompt('Agent Group:','A','Activity\Agent Group',Multi,Constrained,Persistent,{' ALL'},User:9)

union all
SELECT distinct AGENT_NAME CONST_VALUE, 1 SEQ_NUM
FROM
RESOURCE_GI2 INNER JOIN RESOURCE_GROUP_FACT_ ON (RESOURCE_GROUP_FACT_.RESOURCE_KEY=RESOURCE_GI2.RESOURCE_KEY)
inner join         GROUP_ on (GROUP_.GROUP_KEY=RESOURCE_GROUP_FACT_.GROUP_KEY )
WHERE
RESOURCE_GI2.RESOURCE_TYPE_CODE='AGENT'
AND (( ' ALL' IN @Prompt('Agent Group:','A','Activity\Agent Group',Multi,Constrained,Persistent,{' ALL'},User:9))
OR (GROUP_.GROUP_TYPE_CODE in ('AGENT','UNKNOWN','NO_VALUE') and GROUP_.GROUP_NAME IN @Prompt('Agent Group:','A','Activity\

Agent Group',Multi,Constrained,Persistent,{' ALL'},User:9))
) ) s order by SEQ_NUM, 1
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7. On the Query Panel, click OK to save the modified LOV definition.
8. Repeat Steps 2–7 to modify the queue_lov definition in the Queue class. Copy the SQL code from the

queuecascade_lov—the LOV associated with the Queue Cascade dimension. These two LOV
modifications affect the Agent Name and Queue dimensions in all classes in which the dimensions
exist throughout the universe and in which they are paired with the agentname_lov and queue_lov
LOVs.

9. Save the universe and export your changes to the repository to make them available to the reporting
community.

10. In Web Intelligence, for each affected report, edit the query to remove a group condition—where it
exists—and save the report. This includes the following conditions:
• Group Combination
• Group Combination ABN
• Group Combination ANS
• Group Combination Detail Session
• Group Combination Detail State
• Group Combination Rsn
• Group Combination Sess

Unless other significant modifications are made, do not remove the Agent Group condition from
the Agent Group reports; these reports do not reference the Agent Name dimension.

Modify the Report Query

To add cascading prompts to one or more reports by using the modify-the-report-query approach:

[+] Show Steps

1. Make a copy of the report you want to customize. Reports that include either or both the Agent Name
and Queue conditions are for incorporating agent- and queue-cascade functionality.
Note that the Agent Group reports reference the Agent Group condition instead of Agent Name;
these reports are not suitable for cascade prompt customization unless you make other significant
modifications.

2. In Web Intelligence, edit the report query to perform the following modifications. Where it exists:
a. Replace the Agent condition with the Agent Cascade condition.
b. Replace the Queue condition with the Queue Cascade condition.

It does not suffice merely to add cascading objects to a report; you must remove the regular conditions.
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Accessing the Advanced Prompts Panel

c. Remove any group condition from the report. (See step 10 of Modify the Universe LOVs for more
information.)

d. Save the report.
After you make these modifications, users of this report who run the report using the Advanced Prompt Panel (as shown in the
figure Accessing the Advanced Prompts Panel) are prompted to select agents or queues from a particular group instead of
from a listing of all agents (or queues) who belong to the tenant (or contact center).

Limitations on Cascading Prompts

You can design cascading prompts for contact center relationships for any universe object that uses
an LOV and that can be used in conditions. The GI2 universe provides only the two mentioned in this
section to retrieve:

• A listing of agents from a group of agents.
• A listing of queues from a group of queues.
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Reporting Outside the GMT Time Zone
A standard Genesys Info Mart deployment using the default DATE_TIME calendar yields reporting in
the Genesys Info Mart default time zone only. There are, however, other supported deployments
allowing:

• One tenant reporting across multiple time zones
• Multiple tenant reporting within one common time zone
• Multiple tenant reporting using a different time zone for each tenant

To configure Genesys Info Mart to accomplish this type of reporting within GI2 using one universe and
multiple connections:

1. Configure additional calendars in Genesys Info Mart; for example, DATE_TIME_CNT and
DATE_TIME_AET. See Creating Custom Calendars section in the Genesys Info Mart Deployment Guide
for further instructions.

2. Identify the created calendars to RAA:
a. Create an ASCII file that contains the following code (substitute the AET and CNT time zones and

their offsets with your desired time zone(s) and their corresponding offsets):
;This code identifies time zones to RAA
(~time-zone CNT "DATE_TIME_CNT" -12600 -9000)
(~time-zone AET "DATE_TIME_AET" +36000 +39600)
;This code instructs RAA to use the AET time zone when
;populating data for only those aggregation hierarchies that
;are listed
(add-other-tz AET

(hierarchies: H_AGENT H_QUEUE
H_AGENT_QUEUE H_QUEUE_ACC_AGENT H_QUEUE_ABN H_ID
H_I_AGENT H_I_SESS_STATE H_I_STATE_RSN
H_AGENT_CAMPAIGN H_CAMPAIGN))

;This code make all hierarchies CNT-time zone aware
(add-standard-hierarchies-in-tz CNT)

b. Save this file in the Genesys Info Mart root folder with the file name time-zones.ss. The
aggregation process must be able to locate this file from the location where aggregation is run.

3. Invoke aggregation. RAA creates a separate set of database objects for each calendar and names the
objects with the time zone’s abbreviation (AG2_AET_AGENT_SUBHR). RAA manages these objects within
the main schema.

4. Create a schema in Genesys Info Mart for each tenant. Users should not directly reference objects in the
main schema, so you must create aliases to control the access that users have to Info Mart data.

5. Create an alias file, (for example: tenant-tz-alias.ss), following the instructions in “Format of the
Tenant Alias File” in the Reporting and Analytics Aggregates User’s Guide. For example:
(aliases-for-account name: <tenant1_schema_name> login: "<tenant1_user>" password:
"<tenant1_pwd>"
(tenants: <tenant1_key>) (time-zone: PST))
(aliases-for-account name: <tenant2_schema_name> login: "<tenant2_user>" password:
"<tenant2_pwd>"
(tenants: all) (time-zone: EST))
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6. To update tenant aliases, invoke aggregation in standalone mode by issuing the following command:
java -jar agg/GIMAgg.jar -conf runagg -updateAliases tenant-tz-alias.ss
RAA creates views in the specified schema(s) that employ standard names. Therefore, no change to the
definitions of measures, dimensions, or conditions is required in the GI2 universe. Each tenant account
now sees data in their own time zone.

7. Open the Information Design Tool, and create connection parameters for each tenant account. At the
Login Parameters screen of the Wizard Connection, specify the parameters to connect to the desired
tenant schema. Refer to “Linking the Universe to Your Data Mart” in the Genesys Interactive Insights
Deployment Guide for more information.

Through the connection parameters that you establish (and depending on how calendars are set up),
your users have access to their own data and the GI2 reports display this data in the user's time
zone.
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Setting the Scope of Analysis

Scope of Analysis for the Agent Conduct Report

When you run and save a report, BI software stores analytical information about the report in the
report’s cube. This information includes referenced universe elements, the database query, the
returned results, and the report’s scope of analysis, which defines the degree of data that is retrieved
from the data mart as the result of a query. This degree of data corresponds directly to the additional
hierarchical levels, lower than those initially designed to be included in the query. The figure Scope of
Analysis for the Agent Conduct Report shows the Scope of Analysis dialog for the Agent Conduct
Report. This dialog becomes visible when you edit a report’s query within Web Intelligence and click
the Show/Hide Scope of Analysis Panel icon on the menu bar.

By default, the GI2 reports have the Scope of Analysis set to None; this means that no extra data
is stored within the report cube other than the dimensions that are directly used by the query to
organize and retrieve results. This minimizes the size of a report cube and maximizes the report
performance by reducing the time required to run the report (retrieve data from the Data Mart) and
display the results. However, to make extra data available to your users, you can customize each
report to broaden its scope of analysis. You can change the Scope of Analysis to:

• One level
• Two levels
• Three levels
• Custom (Custom permits you to selectively designate the additional objects that should be included in

the query.)

Refer to the BO/BI documentation for further information about this feature.
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Troubleshooting Incompatibility
It is possible for your custom reports to generate results that are difficult to interpret, to generate
errors, or to require excessively long query-processing times when certain combinations of GI2
measures and dimensions are included in the report. These conditions can occur under several
circumstances, including:

• Improperly combining incompatible dimensions—such as the Queue and State Name dimensions—in the
same report.

• Improperly combining disposition and interval measures in the same report.

For this reason, Genesys recommends that when you create or customize new reports, you try to
employ measures and dimensions that belong to the same class. Additionally, you should select one
or more dimensions from the Time class in every report. Observing this simple rule will minimize
errors and confusion among your report users.

Incompatible Objects

Incompatible Objects Error Message

Incompatibilities can result if you add to your custom reports measures and dimensions from different
classes—even if you mix objects from a parent and its subclasses. Web Intelligence displays an error,
shown in the figure to the right, when it encounters an incompatibility.

To resolve this problem, you can modify the existing contexts to add joins between tables—where
they can be joined—or you can create new contexts defining these relationships. In scenarios where
two tables cannot be joined, avoid mixing measures and dimensions within the same report.
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Ambiguous Queries

The Query Contexts Dialog Box
(Appears When the Report Query is Ambiguous)

If you build custom reports—even when you select objects from the same class—the Query
Contexts dialog box can appear, as shown in the figure The Query Contexts Dialog Box. Web
Intelligence displays this dialog box when the resulting query of your custom report is
ambiguous—that is, when the query does not uniquely identify the table from which data should be
retrieved. On the contrary, an ambiguous query can be executed against more than one table in the
database.

For example, if you fail to include in your report a time-related dimension, then Web Intelligence
displays the Query Contexts dialog box before the query is executed—because like results are
stored in all of the _SUBHR, _HOUR, _DAY, _WEEK, _MONTH, _QRTR, and _YEAR aggregation tables
and views. Only after you have specified the appropriate context (the appropriate time dimension in
this case) can Web Intelligence display the report’s results.

As another example, if you attempt to run a custom report in which you added only the Queue and
Queue Group dimensions from the Queue class (from GI2_Universe) to the query definition and
nothing else, a message similar to that shown in the The Query Contexts Dialog Box figure appears.
Queue-related data from this class can be retrieved from any of the following aggregate tables:

• AG2_AGENT_QUEUE_*
• AG2_QUEUE_*
• AG2_QUEUE_ABN_*
• AG2_QUEUE_ACC_AGENT_*
• AG2_QUEUE_GRP_*
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Such a query, without any measures or a time-related dimension, provides insufficient information for
Web Intelligence to determine the table (or view) from which it should retrieve the desired data.

To supress the message, so that users of your report do not see it, add the appropriate universe
elements that satisfy Web Intelligence’s request for additional information. Even if you choose not to
display these elements in the report, make them part of the underlying query. Optionally, you can
preselect the appropriate context, so that the message will not be displayed to users. Refer to BO/BI
documentation for information on how to create contexts.

Finally, as is the case with any report design, study the results of your generated custom report to
ensure that they make sense.

GI2 releases that are incompatible with BI 4.2

In scenarios where you have installed SAP BI 4.2 with unsupported GI2 releases (GI2 8.5.000), drilling
up from Agent to Agent Group in customized reports can fail, producing an error message such as:

Modify joins for these Queue dimensions

Modify joins for these Queue Group dimensions
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Modify joins for these Agent Name dimensions

Modify joins for these Agent Group dimensions

Modify LOVs

The following database error occured: The multi-part identifier 'GROUP_GROUP_TYPE_CODE' could
not be bound...

.
In these scenarios, Genesys recommends that you upgrade to GI2 release 8.5.001.02 or later, which
interoperates correctly with BI 4.2. Alternatively, you can customize GI2 to work correctly with BI 4.2
by using the instructions in the following procedure.

Important
Genesys recommends that you install GI2 with the recommended releases of
supporting software, including RAA, Gensys Info Mart, and BI 4.x software. Compatible
releases are listed in the 8.5 Product Alerts, available on the Genesys Interactive
Insights page.
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Editing the universe so that older versions of GI2 can work with BI 4.2
To resolve problems with drill operations (Agent up to Agent Group) in scenarios where you have
installed BI 4.2 with releases of GI2 that do not support it, make the following changes to the
universe:

1. In the class Service Objects, add the following new conditons:
• Resource Type Agent: RESOURCE_GI2.RESOURCE_TYPE_CODE = 'AGENT' and

RESOURCE_GI2.RESOURCE_TYPE = 'Agent'

• Resource Type Queue: RESOURCE_Q.RESOURCE_TYPE_CODE = 'QUEUE'
• Resource Type Queue and None: RESOURCE_Q.RESOURCE_TYPE_CODE in ('QUEUE','NONE',

'UNKNOWN')

• Group Type Queue: GROUP_Q.GROUP_TYPE_CODE in ( 'QUEUE','UNKNOWN','NO_VALUE')
• Group Type Agent: GROUP_.GROUP_TYPE_CODE in ('AGENT', 'UNKNOWN', 'NO_VALUE')

2. For each of the following dimensions, in all classes except the details classes, remove the Where
clause:
• Agent Name
• Agent Group
• Queue
• Queue Group

3. Modify the following joins to support deleted Where expressions:
• For Agent Name dimensions, modify the joins for the dimensions shown in the figure Modify joins

for these Agent Name dimensions.
• For Agent Group dimensions, modify the joins for the dimensions shown in the figure Modify joins

for these Agent Group dimensions.
• For Queue dimensions, modify the joins for the dimensions shown in the figure Modify joins for

these Queue dimensions.
• For Queue Group dimensions, modify the joins for the dimensions shown in the figure Modify joins

for these Queue Group dimensions.

4. Modify the definitions of the following LOVs, as shown in the figure Modify LOVs, to reflect the
corresponding condition from the Service Objects class: queue_lov, queuegroup_lov,
queueandnone_lov, agentname_lov, agentgroup_lov
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Managing Performance
This page describes steps you can take to improve the performance of GI2.

Maintaining High Performance

Some elements are repeated throughout the universe for convenience, to reduce the potential for
incompatibilities (see Troubleshooting Incompatibility), and also to improve report-query
performance, including all time-related conditions that exist in more than one class:

[+] More Information

• DateRange—in the Activity, Agent Contact, Business Attribute, Contact Attempt, and Time classes
• PreSetAndDate—in the Activity, Agent Contact, Business Attribute, Contact Attempt, Summarized State,

and Time classes
• PreSetAndDateRange—in the Activity, Agent Contact, Business Attribute, Contact Attempt, Queue,

Summarized State, and Time classes
• PreSetAndDayAndTimeRange—in the Handling Attempt and Transfer classes

In previous releases, many of the reports referenced date-time keys that directly queried records in
the DATE_TIME table; this required an additional join from the aggregate table to the DATE_TIME
table—which is a sizeable table filled with thousands of rows of metadata. Beginning with the 8.0
release, some of these date-time references within the reports have been redirected to query the
date and time fields within the reports’ base aggregate tables themselves—constituting a simpler
design that requires one fewer complex join. As a direct result, performance for those reports
improved over the 7.6 release.

As you build new reports or customize the provided reports, be sure to weigh the decision to employ
date-time elements from the Time class with the decision to employ those elements—where they
exist—from the universe class that supports your report’s underlying aggregate tables and views.

Optimal Time to Run Reports

The GI2 reports provide a snapshot of contact center and enterprise activity as of the most recent
transformation and aggregation in the Info Mart database. For completed interactions in completed
reporting intervals that occurred prior to the last transformation and aggregation runs, the reports
provide consistent results each time the reports are run. However, results can differ for interactions
that are still active, or for intervals that are incomplete. For example, running a month-type report
mid-month yields results that differ from those that are obtained by running the same monthly report
at the end of the month.

[+] More Information
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Important
As with other Genesys applications, GI2 requires that your system GMT (Greenwich
Mean Time) setting is accurate and synchronized among the servers in your
environment.

The headers of each report display the report date (which is the date and time when the report was
run) rather than the date and time when the most recent transformation job was run. In fact, the date
and time when the most recent transformation job was run are not reflected in the report, even
though it is that date and time at which contact center activity is reflected by the report data.

For the smaller aggregation levels, the variances in report results are more pronounced, given the
configuration within the Genesys Info Mart application of the data chunk size that is to be
transformed. Genesys Info Mart is an historical-reporting application, therefore you must give care to
the interpretation of report results when you use GI2 as a near real-time tool to obtain daily reports
(for example, when the day has not yet completed or has only recently completed).

Many factors contribute to latency in data availability between the date and time of the most recent
transformation and aggregation run, and the date and time when the report is run, including the
following:

• Scheduling of ETL jobs and job performance.
• Interaction volume, and the number of segments per interaction.
• Number of configured key-value pairs.
• Hardware and RDBMS that are used in your environment.
• Performance of ICON’s merge procedure.

Read more about these factors in the Genesys Info Mart documentation, and in the Genesys
Hardware Sizing Guide.

Preventing WebI Server Problems

As your Info Mart database accumulates large amounts of contact center data, it becomes possible
for users to request a report containing a very large amount of data. It is possible for such a report to
stop the BI system, because when BI software retrieves data, it stores the data in memory. If the BO
software has insufficient memory to handle a report with large amounts of data, or if the BI software
is charged to handle requests from too many concurrent users running reports in parallel, an overflow
occurs, and the software displays the following error message:
Unexpected behavior: Java heap space.

To prevent overflow due to insufficient memory, Genesys recommends that you perform one or more
of the following procedures:

Manage the Memory Pool Size of Your Web Server
Microsoft Windows x86 applications are limited to 2
GB each for maximum memory pool size. The
default memory pool size for the Tomcat web
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server application that is deployed with BO,
however, is 1 GB. To increase this value, you can
modify Tomcat configuration to set the maximum
memory pool size to a value within the
1,200–1,500 MB range. Having this maximum
number of pre-allocated memory blocks available
for Tomcat enables memory allocation with
constant execution.
[+] Show Steps
To change this setting for the Tomcat application, perform the
following steps:

1. On your Microsoft Windows platform, open the
Tomcat program group and select Tomcat
Configuration.

2. In the Apache Tomcat Properties window, on the
Java tab, set the Initial memory pool size to
512, and the Maximum memory pool to a value
between 1,200 MB and 1,500 MB.

3. Restart Tomcat.
Refer to the SAP BusinessObjects Enterprise Administrator's
Guide for additional information (see BO/BI documentation).

Manage the Virtual Memory of Your Host

When your computer lacks adequate physical
memory to perform an operation or run a program,
Microsoft Windows uses virtual memory to
compensate. For efficient GI2 operation, set the
amount of virtual memory to a size at least 1.5
times that of your host’s RAM.
To adjust virtual memory configuration, refer to the
documentation provided by Microsoft.

Manage the WebI Document Cache

Depending on the design of a GI2 report and the
types of actions being performed against it,
memory requirements vary. The peak memory
usage for a Web Intelligence document occurs
when you refresh a report, because BI must query
the Info Mart database and transfer the entire
dataset to the Web Intelligence server.
File caching allows BI web services to handle very large
attachments without buffering them in memory. File caching
compromises performance because BO’s web services must
process information by using files instead of memory. If file
caching is not enabled, however, all JVM memory could be
utilized when handling very large attachments and replication
can fail. You can configure BI web services to use file caching for
large transfers to a file and to use memory for smaller files.

[+] Show steps
To manage the Web Intelligence document cache, perform the
following steps:

1. Within the Central Management Console (CMC),
click Servers.

Managing Performance Troubleshooting Incompatibility

Genesys Interactive Insights User's Guide 96



Setting Web Intelligence Processing Parameters

2. Expand Service Categories, and open the
properties of Web Intelligence Processing
server. The figure Setting Web Intelligence
Processing Parameters shows the default
values in WebI properties.

3. Set the value in the Document Cache
Cleanup Interval field to 600 seconds.

4. Set the value in the Cache Timeout field to 20
minutes. This value indicates how often the BI
software will clear the document cache.

5. If it is checked, clear the Disable Cache
Sharing checkbox.

6. Set the value in the Maximum Document
Cache Size field to 10240 KB.

7. Restart the Web Intelligence Processing server.
Refer to the SAP BusinessObjects Enterprise Administrator’s
Guide (or the Business Intelligence Platform Administrator
Guide) and the relevant SAP Sizing Companion Guide for further
information (see BO/BI documentation).
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Additional Resources

Genesys Info Mart

Documentation for Genesys Info Mart is available on the Genesys Documentation website:

• Genesys Info Mart Operations Guide, for information about Genesys Info Mart jobs such as
Job_AggregateGIM, and the Genesys Info Mart Manager, which you can use to manage Genesys Info
Mart jobs.

• Genesys Info Mart Deployment Guide, for information about configuring the Genesys Info Mart and
Interaction Concentrator servers to recognize user data.

Reporting and Analytics Aggregates

Documentation for Reporting and Analytics Aggregates (RAA) is available on the Genesys
Documentation website:

• Reporting and Analytics Aggregates Deployment Guide, which describes the runtime parameters and
configuration options mentioned in this document.

• Reporting and Analytics Aggregates User’s Guide, which describes the different modes of running
aggregation, the aggregation hierarchies, and how to configure Reporting and Analytics Aggregates
(RAA) to aggregate data based on these user-defined dimensions.

• The Physical Data Model documentation for your RDBMS, which describes the aggregate tables and
subject areas:
• Reporting and Analytics Aggregates Physical Data Model for a Microsoft SQL Server Database

• Reporting and Analytics Aggregates Physical Data Model for an Oracle Database

• Reporting and Analytics Aggregates Physical Data Model for a PostgreSQL Database

Genesys Interactive Insights

Important
Genesys Interactive Insights (GI2) 8.5 entered End of Life (EOL) on January 25, 2019.
It enters End of Maintenance on July 28, 2020, and reaches End of Support on January
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24, 2021. If you have questions, contact your account representative. GI2 is replaced
by Genesys CX Insights.

Documentation for Genesys Interactive Insights (GI2) is available on the Genesys Documentation
website:

• Genesys Interactive Insights Deployment Guide, which will help you install, start, stop, and uninstall the
Genesys-provided image of BI and the GI2 reports and universe.

• Genesys Interactive Insights Universe Guide, which describes, in detail, the reports and measures that
are provided in the GI2 release.

• Genesys Interactive Insights User's Guide, which includes a report- customization example that displays
aggregated results that are sectioned by your own custom user data.

BusinessObjects Business Intelligence Platform 4.1

Documentation for BusinessObjects Business Intelligence Platform 4.1 (BI) is provided by SAP (see BO
Documentation):

• Business Intelligence Platform User Guide—SAP BusinessObjects Business Intelligence Platform 4.1
Support Package

• Business Intelligence Launch Pad User Guide—SAP BusinessObjects Business Intelligence Platform 4.1
Support Package

• Information Design Tool User Guide—SAP BusinessObjects Business Intelligence platform 4.1 Support
Package

Genesys

Additional documentation for Genesys products is available, as follows:

• The Genesys Glossary provides a comprehensive list of the Genesys and computer-telephony
integration (CTI) terminology and acronyms.

• Genesys Migration Guide, available on the Genesys Documentation website, provides documented
migration strategies for Genesys product releases. Contact Genesys Customer Care for more
information.

• Release Notes and Product Advisories for this product, which are available on the Genesys
Documentation website.

Information about supported hardware and third-party software is available on the Genesys
Documentation website in the following documents:

• The Genesys Interactive Insights page in the Genesys Supported Operating Environment Reference
Guide
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• Genesys Supported Media Interfaces Reference Manual

• Genesys Hardware Sizing Guide, which provides information about Genesys hardware sizing guidelines
for the Genesys 8.x releases. For additional system-wide planning tools and information, see the
release-specific listings of System-Level Documents on the Genesys Documentation website
(docs.genesys.com).

Genesys product documentation is available on the:

• Genesys Customer Care website
• Genesys Documentation website
• Genesys Documentation Library DVD, which you can order by email from Genesys Order Management

at Genesys Order Management.
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